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1 Introduction

1.1 Overview

Overview of AddEmail ActiveX

The AddEmail ActiveX enables your application to send e-mail messages. AddEmail was designed to
work with all development environments that support COM objects, ActiveX or OCX controls. Easy-to-
use and flexible object model allows application developers to implement e-mail support without a
time-consuming learning curve. AddEmail was developed for today's most demanding applications and
was thoroughly tested to ensure enterprise-level reliability and stability. The AddEmail ActiveX license
agreement allows you to embed and distribute AddEmail within your application, royalty free. Main
features of AddEmail ActiveX are:

Send e-mails using SMTP and ESMTP protocols with optional authentication and SSL encryption.

Send text or HTML e-mails with any number of attachments.

Create or import HTML e-mails with embedded images.

Supports e-mails with multiple recipients in To, Cc and Bcc fields.

Sends large e-mails asynchronously without blocking your application.

Progress and status events allow to implement user-friendly Ul: progress indicator, cancel button

etc.

e Sends several e-mails simultaneously without any multi-threading support in your application
(AddEmail Enterprise version only).

e Sends e-mails directly to recipients' mail servers without using SMTP server of your organization or

internet provider (AddEmail Enterprise version only).

Developer Support

Please visit Traysoft Developer Tools website at www.traysoft.com for the latest version of this
manual. You can also find additional samples, news, updates and other AddEmail-related information
on this website.

If you have any feedback or any questions please contact us or send an e-mail to the following
address. We respond to all inquires within 1-2 business days.

e devtools@traysoft.com

1.2 What's new in version 3.0

AddEmail ActiveX 3.0 adds several new features and improvements while maintaining complete
compatibility with previous versions. Source code written for AddEmail ActiveX 1.x and 2.x should
compile and work with AddEmail ActiveX 3.0 without any modifications. New features added to version
3.0 are listed below. For a complete list of changes please refer to the Version History.

Windows 7 and Windows Server 2008 R2 compatibility

AddEmail ActiveX 3.0 is fully compatible with all editions of Windows 7 and Windows Server 2008 R2,
64-bit and 32-bit versions. On 64-bit OS please use 32-bit version of regsvr32 to register AddEmail.dll
on the computer. Run command prompt as an Administrator and type in:

c:\wi ndows\ syswow64\ r egsvr 32 c:\addenai | \ addenai | . dl |

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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1.3

(assuming you copied AddEmail.dll to C:\AddEmail\ folder). You should see a message saying that the
dll was registered successfully.

Automatic import of HTML with embedded images

With new version your program can automatically create HTML emails with embedded images by
importing HTML files from disk. AddEmail imports specified HTML file, adds all images referenced in
the HTML as inline attachments and modifies HTML as needed. Please refer to ImportHTML and
SimpleSendHtml topics for more information.

SimpleSendXXX methods allow to specify sender's and recipients' names

New version adds support for "First LastName <name@domain.com>" format to SimpleSend,
SimpleSendHtml and SimpleSendAttachment methods. Now you can specify names in addition to e-
mail addresses for sender and recipients in SimpleSendXXX methods.

Support for Unicode (non-ASCIl) attachment names

New version supports Unicode characters in MailAttachment.File and MailAttachment.Name
properties. AddEmail will automatically encode attachment name if it has any non-ASCII characters.

ReplyTimeout property

New property has been added to specify how long AddEmail waits for a response from SMTP server
before reporting timeout error. Please refer to ReplyTimeout topic for more information.

What's new in version 2.0

AddEmail ActiveX 2.0 adds many new features and improvements while maintaining complete
compatibility with previous versions. Source code written for AddEmail ActiveX 1.x should compile and
work with AddEmail ActiveX 2.0 without any modifications. New features added to version 2.0 are listed
below.

Secure connection (TLS/SSL) support

Version 2.0 supports encrypted (TLS/SSL) connection to SMTP servers. Set SmtpSSL property to True
if you want to use TLS/SSL connection, for example when using smtp.gmail.com server on port 465.

Secure Password Authentication (SPA) support

Version 2.0 supports Secure Password Authentication (SPA). If your SMTP server requires SPA
please set SmtpSPA property to True in order to use SPA authentication method. Please note that
some servers are configured to require SmtpUsername in username@domain.com format for SPA
authentication.

Windows Vista support

Version 2.0 was extensively tested on Windows Vista and supports all Windows Vista editions. Please
note that new security feature of Windows Vista called User Account Protection (UAP) prevents regular
programs from writing to the HKEY_CLASSES ROOT registry branch. Because of that, administrator
privileges are required to register AddEmail.dll on Windows Vista. Only registration requires
administrator privileges. After AddEmail.dll is registered on the target computer, it can be used to send
e-mails from any program without administrator privileges.

New features of SimpleSend methods

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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Version 2.0 adds new SimpleSendAttachment method which allows to send text or HTML e-mails with
any number of attachments to multiple recipients using just one method call. SimpleSend method also
was modified to support text and HTML e-mails with multiple recipients. Please refer to the
SimpleSend and SimpleSendAttachment topics in this manual for more information.

Improved Unicode support

Version 2.0 automatically detects Unicode characters and creates Unicode e-mails even if
MessageBodyCharset property is not set. In addition, version 2.0 supports Unicode in the subject or in
the body of the message when you use SimpleSend or SimpleSendAttachment.

Improved SMTP engine for sending e-mails directly (Enterprise version only)

SMTP engine in version 2.0 was updated to improve speed and compatibility when sending e-mails
directly without using SMTP server of your organization or internet provider. New SenderHostname
property allows to specify fully-qualified domain name of the sending computer. Please refer to the

SenderHostname topic in this manual for more information.

New methods for obtaining error code and error description

GetLastErrorCode and GetlLastErrorDescription methods were added in version 2.0 to improve
compatibility with programming languages that do not support out parameters, e.g. JavaScript. These
methods allow to obtain error code and error description of the last synchronous send operation.

Improved MIME engine

New MIME engine in version 2.0 creates e-mails that closely resemble e-mails created by Outlook,
reducing probability that e-mails sent using AddEmail will be blocked by a spam filter.

Read receipt support

With previous versions of AddEmail custom header had to be added to the message to request a read
receipt. To request read receipt with version 2.0 set RequestReadReceipt property of MailMessage
object to True.

1.4 Legal Information

Legal Information for AddEmail 3.0 User Manual

While every precaution has been taken in the preparation of this document, Traysoft Inc. assumes no
responsibility for errors or omissions, or for damages resulting from the use of information contained in
this document or from the use of programs and source code that may accompany it. In no event shall
Traysoft Inc. be liable for any loss of profit or any other commercial damage caused or alleged to have
been caused directly or indirectly by this document.

Information in this document is subject to change without notice and does not represent a commitment
on the part of Traysoft Inc. Companies, names, and data used in examples herein are fictitious unless
otherwise noted. No part of this document may be reproduced or transmitted in any form or by any
means, electronic or mechanical, for any purpose, unless expressly permitted by Traysoft Inc.

Traysoft Inc. may have patents or pending patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. The furnishing of this document
does not give you any license to these patents, trademarks, copyrights, or other intellectual property
rights.

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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1.5

1.6

System Requirements

Operating Systems
Supported operating systems are:

Microsoft Windows 7 all editions.

Microsoft Windows Vista all editions.

Microsoft Windows XP all editions.

Microsoft Windows 2008 Server editions.

Microsoft Windows 2003 Server editions.

Microsoft Windows 2000 Professional Workstation or Server.
Microsoft Windows Millennium.

Microsoft Windows 98 all editions.

Microsoft Windows NT Workstation or Server 4.0, service pack 6a.
Microsoft Windows 95 (requires Winsock 2.0 update).

Development Environment

AddEmail can be used with any development environment that supports COM (ActiveX) objects,
including:

Microsoft Visual Studio .NET 2002, 2003, 2005, 2008 and 2010

Microsoft Visual C++ 5.0 and 6.0

Microsoft Visual Basic 5.0 and 6.0

Microsoft Visual FoxPro

Microsoft Visual J++

Microsoft Office 97, Office 2000, Office XP, Office 2003, Office 2007 and Office 2010
ASP and ASP.NET

Borland C++ Builder

Borland Delphi

Sybase PowerBuilder

Supported operating systems for development are:

Microsoft Windows 7 all editions.

Microsoft Windows Vista all editions.

Microsoft Windows XP all editions.

Microsoft Windows 2008 Server editions.

Microsoft Windows 2003 Server editions.

Microsoft Windows 2000 Professional Workstation or Server.

Redistributable Code

The Redistributable Code is the property of Traysoft Inc. and its suppliers and is protected by copyright
law and international treaty provisions. You are authorized to make and use copies of the
Redistributable Code either as part of the application in which you received the Redistributable Code,
or in conjunction with the application for which its use is intended. Except as expressly provided in the
End User License Agreement, you are not authorized to reproduce and distribute the Redistributable
Code. Traysoft reserves all rights not expressly granted. You may not reverse engineer, decompile, or
disassemble the Redistributable Code, except and only to the extent that such activity is expressly

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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permitted by applicable law notwithstanding this limitation.

THE REDISTRIBUTABLE CODE IS PROVIDED TO YOU "AS IS" WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR PURPOSE. YOU
ASSUME THE ENTIRE RISK AS TO THE ACCURACY AND THE USE OF THE REDISTRIBUTABLE
CODE. TRAYSOFT SHALL NOT BE LIABLE FOR ANY DAMAGES WHATSOEVER ARISING OUT
OF THE USE OF OR INABILITY TO USE THE REDISTRIBUTABLE CODE, EVEN IF TRAYSOFT
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Redistributable Code

Redistributable Code is identified as the following files and all of the files can be found at the following
location:

Traysof t\ AddEmai | \ Redi st r\
Files:

AddEmail.dll - COM DLL that contains all AddEmail objects. AddEmail.dll is a self-registered COM
DLL. If you are using setup builder such as InstallShield or Wise Installation Studio, simply add
AddEmail.dll to the setup project and mark AddEmail.dll as "Self-register".

RegAddEmail.bat - Batch file for manual registration of AddEmail.dll. To register on a target computer
copy AddEmail.dll and RegAddEmail.bat to the target computer then execute RegAddEmail.bat. On
Windows Vista and Windows 7, please right-click on RegAddEmail.bat and select "Run as
Administrator" then click "Allow".

non-Unicode\AddEmail.dll - Alternative version of AddEmail.dll for non-Unicode versions of Windows
98 and Windows ME.

9X\DnsApi.dll - DNS library for Windows 95/98/ME (AddEmail Enterprise version only). Copy this file to
Windows System32 folder.

NT4\DnsApi.dll - DNS library for Windows NT 4.0 (AddEmail Enterprise version only). Copy this file to
Windows System32 folder.

1.7  Version History

Version 3.0

- Full Windows 7 and Windows Server 2008 R2 support.

- Added HTML import. Now HTML emails with embedded images can be created automatically by
importing HTML file from disk.

- Added support for "First LastName <name@domain.com>" format to all SimpleSendXXX methods.
- Added support for Unicode (non-ASCIl) attachment names.

- Added ReplyTimeout property to specify how long AddEmail waits for a response from SMTP server
before reporting timeout error.

- Improved error reporting for socket errors and SMTP protocol errors.

- Added checks for invalid symbols in e-mail addresses.

- Updated documentation and added new samples.

Version 2.1.1

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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- Added checks for proper format of sender's hostname when it's generated from computer name.
- Fixed a bug that was causing InitializeSecurityContext error with some SSL/TLS servers.

Version 2.1

- Added ConnectAttempts property to specify number of times AddEmail tries to connect to the SMTP
server before reporting connection error.

- Added GetQueueSize method which returns number of e-mails queued for sending.

- Fixed a problem that prevented AddEmail from establishing SSL/TLS connection to some SMTP
servers such as smtp.bizmail.yahoo.com and smtp.att.yahoo.com.

- Now AddEmail doesn't return timeout error if SMTP server takes a very long time to process an e-
mail with large attachments.

- Added SetSender and SetReplyTo methods in order to support PowerBuilder 6.

Version 2.0.2
- Added support for custom From, To and Cc headers.
- Fixed a problem with text attachments in SimpleSendAttachment.

Version 2.0.1

- Improved SSL/TLS support.
- Updated C# 2005, VB.NET 2005 and ASP.NET 2.0 samples.

2 Samples and Tutorials

2.1 C++/MFC/ATL

2.1.1 Using AddEmail in C++ projects

To use AddEmail in your C++ project perform the following steps:

1. Import AddEmail type library: add #import directive to StdAfx.h or other appropriate header.

#i nport "AddEmai | \ AddEnai | . t1 b" naned_gui ds

2. Declare variable that will hold a reference to the SmtpMail object:
private AddEmail Lib::1SnmtpMil Ptr mspSnt pMil;

3. Create an instance of the SmtpMail object:

m spSnt pMai | . Creat el nst ance( __uui dof (AddEnmi | Li b: : SntpMai | ));
4. Set SMTP server address, port, username and password:

m_spSnt pMai | - >Put Snt pServer ("nmai | . myserver. cont');

m_spSnt pMai | - >Put Snt pPor t (25) ;

m_spSnt pMai | - >Put Snt pUser nane("j smth");

m_spSnt pMai | - >Put Snt pPasswor d( " mypassword") ;

5a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.
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BSTR bstrError;

int resultCode = m spSnt pMil ->Si npl eSend("j sm th@ryserver. cont,

"j ane@omeserver.com j anes@oneserver.conm', "test", "Test message", &bstrError);
if (resultCode == 0)

/1 E-mail was sent successfully

| se

/1 Send failed, bstrError contains detailed error description

— -~ P,

5b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
asynchronously using SendAsync:

/'l Create nessage and setup subject and body

AddEnai | Li b: : | Mai | MessagePtr spMessage;

spMessage. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Message) ) ;
spMessage- >Put MessageSubj ect ("test");

spMessage- >Put MessageBody(" Test nessage");

/'l Setup sender

AddEnai | Li b: : |1 Mai | AddressPtr spFrom

spFrom Creat el nstance( __uui dof (AddEnai | Li b: : Mai | Address) );
spFrom >Put Addr ess("j smi t h@ryserver.conl);

spFrom >Put Nanme("John Smith");

spMessage- >Put Sender (spFrom ;

/'l Setup first recipient

AddEnai | Li b: : | Mai | AddressPtr spTo;

spTo. Creat el nst ance(__uui dof (AddEnai | Li b: : Mai | Addr ess));
spTo- >Put Addr ess("]j ane@omneserver.com');

spTo- >Put Name("Jane Smith");

spMessage- >AddReci pi ent (spTo) ;

/'l Setup second recipient

spTo. Creat el nst ance(__uui dof (AddEnai | Li b: : Mai | Addr ess));
spTo- >Put Addr ess( "] ames@oneserver. conl);

spTo- >Put Name("James Smith");

spMessage- >AddReci pi ent (spTo) ;

/1 Send prepared nessage

BSTR bstrError;

int resultCode = m spSnt pMil ->Send(spMessage, TRUE, &bstrError);
if (resultCode == 0)

/1 E-mail was sent successfully

}

el se

/1 Send failed, bstrError contains detailed error description

}

/1 Alternatively, send prepared nessage asynchronously
/1int messageNunber = m spSnt pMil - >SendAsync(spMessage, TRUE);

6. If the e-mail is sent asynchronously your application will need to process events to find out when the
email was sent successfully or send operation failed. To process events from the SmtpMail object you
need to add ATL support to your project, inherit your class from IDispEventimpl<> template, declare
event handlers, create sink map and subscribe to events:

class CWd ass :
public |Di spEventlnmpl <1, CWdCd ass, &AddEmmil Lib:: DI D__I| SntpMil Events,
&AddEmai | Li b: : LI Bl D_AddEmai | Lib, 1, 0>
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publi c:
/1 SntpMail events
void __stdcall OnStatusChange(LONG messageNunber, AddEnail Li b:: Mail Status
newst at us) ;
void __stdcall OnProgress(LONG nmessageNunber, LONG bytesSent, LONG bytesTotal);
/1 ATL sink for SmtpMil events
BEG N_SI NK_MAP(CW/d ass)
SINK_ENTRY_EX(1, AddEmmilLib::DiID__ISntpMil Events, 1, OnStatusChange)
SI NK_ENTRY_EX(1, AddEmmilLib::DIID__|SntpMil Events, 2, OnProgress)
END_SI NK_MAP()
}

2.1.2

/'l Subscribe to events
Di spEvent Advi se(m_spSnt pMai | ) ;

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included C++ samples provide code snapshots for common operations such

as sending text e-mails, sending HTML e-mails, adding attachments to e-mails, creating HTML e-mails
with embedded images.

Samples

AddEmail includes the following C++ samples:

SimpleSend Sample

Location: AddEmail\Samples\C++\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails using SimpleSend.
SimpleSendAttachment Sample

Location: AddEmail\Samples\C++\SimpleSendAttachment\

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
using SimpleSendAttachment.

HtmIMail Sample
Location: AddEmail\Samples\C++\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails with attachments using Send. This sample
also shows how to set alternative text-only body of e-mail.

Embeddedimages Sample
Location: AddEmail\Samples\C++\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

EnterpriseMail Sample
Location: AddEmail\Samples\C++\EnterpriseMail\

EnterpriseMail sample demonstrates features of AddEmail Enterprise version. It shows how to queue
and send multiple e-mails simultaneously using AddEmail multi-threading support. This sample also
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shows how to process events from SmtpMail object. In addition, this sample shows how to send e-
mails directly to recipients' mail servers without using outgoing mail server of your organization or
internet provider.

UnicodeMail Sample

Location: AddEmail\Samples\C++\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\C++\SendAsync\

HtmIMail sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync. This sample also shows how to process events from SmtpMail object.

2.2 VB6
2.2.1 Using AddEmail in VB6 projects

To use AddEmail in your Visual Basic 6 project perform the following steps:

1. Add a reference to the AddEmail library: In VB6 main menu, select Project -> References. Find and
select AddEmail 3.0 Type Library.

2. Declare variable that will hold a reference to the SmtpMail object:
Dim Wt hEvents obj Smt pMail As AddEmai | Li b. Snt pMai |

3. Create instance of SmtpMail object in Form_Load() or other functions:

Set obj Smt pMail = New AddEmai | Li b. Snt pMai |
4. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pPort = 25
obj Smt pMai | . Snt pUser name
obj Smt pMai | . Snt pPasswor d

"jsmth"
"nypasswor d”

5a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

Dim strError As String
Di m resul t Code As Long
resul t Code = obj Snt pMai | . Si npl eSend("j sm t h@ryserver. cont',
"j ane@omneserver.com j anes@oneserver.cont', "test", "Test message", strError)
If resultCode = 0 Then

' E-mail was sent successfully
El se

Send failed, strError contains detailed error description

End | f

5b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
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asynchronously using SendAsync:

Create message and setup subject and body
Di m obj Message As New AddEnmi | Li b. Mai | Message
obj Message. MessageSubj ect = "test"
obj Message. MessageBody = "Test nessage"
' Setup sender
Di m obj Sender As New AddEmai | Li b. Mai | Addr ess
obj Sender . Address = "jsmith@ryserver. conf
obj Sender. Nane = "John Smith"
obj Message. Sender = obj Sender
' Setup first recipient
Di m obj Reci pi ent As AddEnai | Li b. Mai | Addr ess
Set obj Reci pi ent = New AddEnmi | Li b. Mai | Addr ess
obj Reci pi ent. Address = "jane@oneserver. conf
obj Reci pi ent. Name = "Jane Smith"
obj Message. AddReci pi ent obj Reci pi ent
' Setup second recipient
Set obj Reci pi ent = New AddEnai | Li b. Mai | Addr ess
obj Reci pi ent. Address = "james@oneserver. conf
obj Reci pi ent. Name = "Janes Smith"
obj Message. AddReci pi ent obj Reci pi ent
' Send prepared nessage synchronously
Dim strError As String
Di m resul t Code As Long
resul t Code = obj Snt pMai | . Send( obj Message, True, strError)
If resultCode = 0 Then

' E-mail was sent successfully
El se

' Send failed, strError contains detailed error description
End If
' Alternatively, send prepared nessage asynchronously
' Di m messageNunber As Long
' messageNunber = obj Snt pMai | . SendAsync(obj Message, True)

6. If the e-mail is sent asynchronously your application will need to process events to find out when the
email was sent successfully or send operation failed. To process events from the SmtpMail object
declare event handlers as shown below:

Private Sub obj Smt pMai | _OnSt at usChange(ByVal messageNunber As Long, ByVal newsStatus
As Long)

' Event processing code
End Sub

Private Sub obj Smt pMai |l _OnProgress(ByVal nmessageNunber As Long, ByVal bytesSent As
Long, ByVal bytesTotal As Long)

' Event processing code
End Sub

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included Visual Basic samples provide code snapshots for common
operations such as sending text e-mails, sending HTML e-mails, adding attachments to e-mails,
creating HTML e-mails with embedded images.
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2.2.2 Samples

AddEmail includes the following Visual Basic 6 samples:
SimpleSend Sample
Location: AddEmail\Samples\VB6\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

SimpleSendAttachment Sample
Location: AddEmail\Samples\VB6\SimpleSendAttachment\

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachment.

HtmIMail Sample
Location: AddEmail\Samples\VB6\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails with attachments using Send. This sample
also shows how to set alternative text-only body of e-mail.

ImportHtmIWithimages Sample
Location: AddEmail\Samples\VB6\ImportHtmIWithimages\

ImportHtmIWithimages sample demonstrates how to import HTML file with embedded images using
ImportHTML.

Embeddedimages Sample
Location: AddEmail\Samples\VB6\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

EnterpriseMail Sample

Location: AddEmail\Samples\VB6\EnterpriseMail\

EnterpriseMail sample demonstrates features of AddEmail Enterprise version. It shows how to queue
and send multiple e-mails simultaneously using AddEmail multi-threading support. This sample also
shows how to process events from SmtpMail object. In addition, this sample also shows how to send
e-mails directly to recipients' mail servers without using outgoing mail server of your organization or
internet provider.

SendAsync Sample

Location: AddEmail\Samples\VB6\SendAsync\

HtmIMail sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync. This sample also shows how to process events from SmtpMail object.
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2.3 C#
2.3.1 Using AddEmail in C# projects

To use AddEmail in your C# project perform the following steps:

1. Add a reference to the AddEmail library: In Visual Studio main menu, select View -> Solution
Explorer to open Solution Explorer. Right-click on the project that will use AddEmail and select Add
Reference from the pop-up menu. Click COM tab, find and select AddEmail 3.0 Type Library, click
Select button then OK button.

2. Declare variable that will hold a reference to the SmtpMail object:
private AddEmail Li b. Snt pMai | G ass obj Snt pMai | ;

3. Create an instance of the SmtpMail object in the constructor of your class:
obj Smt pMai |l = new AddEnmai | Li b. Snt pMai |  ass();

4. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "nmail . nyserver. conf';
obj St pMai | . Snt pPort = 25;

obj Smt pMai | . Snt pUser nane
obj Smt pMai | . Snt pPasswor d

"jsmth";
"nypassword”;

5a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

string strError;

int resultCode = obj SntpMil.SinpleSend("jsnth@ryserver. cont,

"j ane@oneserver.com janes@oneserver.cont', "test", "Test nessage", out strError);
if (resultCode == 0)

/1 E-mail was sent successfully

| se

/1 Send failed, strError contains detailed error description

— -~ P,

5b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
asynchronously using SendAsync:

/'l Create nessage and setup subject and body

Mai | MessageCl ass obj Message = new AddEnai | Li b. Mai | Messaged ass() ;
obj Message. MessageSubj ect = "test";

obj Message. MessageBody = "Test nessage”;

/'l Setup sender

Mai | Addr essCl ass obj Sender = new Mai | AddressC ass();
obj Sender . Address = "jsm th@ryserver. cont;

obj Sender. Nane = "Jane Snith";

obj Message. Sender = obj Sender;

/'l Setup first recipient

Mai | Addr essCl ass obj Reci pi ent = new Mai | AddressC ass();
obj Reci pi ent. Address = "jane@oneserver. coni;

obj Reci pi ent. Name = "Jane Smith";

obj Message. AddReci pi ent (obj Reci pi ent);
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/1l Setup second recipient

obj Reci pi ent = new Mai | Addressd ass();

obj Reci pi ent. Address = "james@oneserver. cont;
obj Reci pi ent. Name = "Janes Snmith";

obj Message. AddReci pi ent (obj Reci pi ent);

/'l Send prepared nessage synchronously

string strError;

int resultCode = obj Snt pMail . Send( obj Message, true, out strError);
if (resultCode == 0)

/1 E-mail was sent successfully

}

el se

/1 Send failed, strError contains detailed error description

}

/1 Alternatively, send prepared nessage asynchronously
/1int messageNunber = obj Snt pMai | . SendAsync(obj Message, true);

6. If the e-mail is sent asynchronously your application will need to process events to find out when the
email was sent successfully or send operation failed. To process events from the SmtpMail object
declare event handlers and subscribe to events:

private void OnStatusChange(i nt nmessageNunber, int newStatus)

/1l Event processing code

}

private void OnProgress(int messageNunber, int bytesSent, int bytesTotal)

/1l Event processing code

}

/'l Subscribe to events

obj St pMai | . OnSt at usChange += new

_1 Smt pMai | Event s_OnSt at usChangeEvent Handl er (OnSt at usChange) ;

obj St pMai | . OnProgress += new _I| St pMai | Event s_OnPr ogr essEvent Handl er ( OnPr ogr ess) ;

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included C# samples provide code snapshots for common operations such as
sending text e-mails, sending HTML e-mails, adding attachments to e-mails, creating HTML e-mails
with embedded images.

2.3.2 Samples

AddEmail includes the following C# samples:
SimpleSend Sample

Location: AddEmail\Samples\C# 2002-2003\SimpleSend\
AddEmail\Samples\C# 2005-2010\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

SimpleSendAttachment Sample
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Location: AddEmail\Samples\C# 2002-2003\SimpleSendAttachment\
AddEmail\Samples\C# 2005-2010\SimpleSendAttachment\

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachment.

HtmIMail Sample

Location: AddEmail\Samples\C# 2002-2003\HtmIMail\
AddEmail\Samples\C# 2005-2010\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails with attachments using Send. This sample
also shows how to set alternative text-only body of e-mail.

ImportHtmIWithimages Sample

Location: AddEmail\Samples\C# 2002-2003\ImportHtmIWithimages\
AddEmail\Samples\C# 2005-2010\ImportHtmIWithimages\

ImportHtmIWithimages sample demonstrates how to import HTML file with embedded images using
ImportHTML.

Embeddedimages Sample

Location: AddEmail\Samples\C# 2002-2003\Embeddedimages\
AddEmail\Samples\C# 2005-2010\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

EnterpriseMail Sample

Location: AddEmail\Samples\C# 2002-2003\EnterpriseMail\
AddEmail\Samples\C# 2005-2010\EnterpriseMail\

EnterpriseMail sample demonstrates features of AddEmail Enterprise version. It shows how to queue
and send multiple e-mails simultaneously using AddEmail multi-threading support. This sample also
shows how to process events from SmtpMail object. In addition, this sample shows how to send e-
mails directly to recipients' mail servers without using outgoing mail server of your organization or
internet provider.

UnicodeMail Sample

Location: AddEmail\Samples\C# 2002-2003\UnicodeMail\
AddEmail\Samples\C# 2005-2010\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\C# 2002-2003\SendAsync\
AddEmail\Samples\C# 2005-2010\SendAsync\

HtmIMail sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync. This sample also shows how to process events from SmtpMail object.
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2.4
241

VB.NET
Using AddEmail in VB.NET projects

To use AddEmail in your Visual Basic .NET project perform the following steps:

1. Add a reference to the AddEmail library: In Visual Studio main menu, select Project -> Add
Reference. Click COM tab, find and select AddEmail 3.0 Type Library, click Select button then OK
button.

2. Declare variable that will hold a reference to the SmtpMail object and create an instance:
Dim Wt hEvents obj SmtpMail As New AddEmai | Li b. St pMai | O ass()
3. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pPort = 25
obj Smt pMai | . Snt pUser namne
obj Smt pMai | . Snt pPasswor d

"jsmth"
"nypasswor d”

4a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

Dim strError As String
Di m resul t Code As I|nteger
resul t Code = obj Snt pMai | . Si npl eSend("j sm t h@ryserver. cont',
"j ane@oneserver.com j anes@oneserver.cont', "test", "Test message", strError)
If resultCode = 0 Then

' E-mail was sent successfully
El se

Send failed, strError contains detailed error description

End | f

4b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
asynchronously using SendAsync method:

Create message and setup subject and body
Di m obj Message As New AddEnmi | Li b. Mai | Messaged ass()
obj Message. MessageSubj ect = "test"
obj Message. MessageBody = "Test nessage"

Set up sender
Di m obj Sender As New AddEnai |l Li b. Mai | Addr essCl ass()
obj Sender . Address = "jsnmith@ryserver. cont
obj Sender. Nane = "John Smith"
obj Message. Sender = obj Sender

Setup first recipient
Di m obj Reci pi ent As AddEmai | Li b. Mai | Addr essCl ass
obj Reci pi ent = New AddEnai | Li b. Mai | Addr essCl ass()
obj Reci pi ent. Address = "jane@oneserver. conf
obj Reci pi ent. Name = "Jane Smith"
obj Message. AddReci pi ent (obj Reci pi ent)

Setup second reci pi ent
obj Reci pi ent = New AddEnai | Li b. Mai | Addr essCl ass()
obj Reci pi ent. Address = "james@oneserver. conf
obj Reci pi ent. Name = "Janes Smith"
obj Message. AddReci pi ent (obj Reci pi ent)
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Send prepared nmessage synchronously
Dim strError As String
Di m resul t Code As I|nteger
resul t Code = obj Snt pMai | . Send( obj Message, True, strError)
If resultCode = 0 Then

' E-mail was sent successfully
El se

Send failed, strError contains detailed error description

End If

Al ternatively, send prepared nessage asynchronously
' Di m nessageNunber As | nteger
' messageNunber = obj Snt pMai | . SendAsync(obj Message, True)

5. If the e-mail is sent asynchronously your application will need to process events to find out when the
email was sent successfully or send operation failed. Declare event handlers to process events from
the SmtpMail object :

Private Sub OnSt at usChange(ByVal messageNunber As Integer, ByVal newStatus As
I nteger) Handl es obj Snt pMai | . OnSt at usChange

Event processing code
End Sub

Private Sub OnProgress(ByVal nessageNumber As |Integer, ByVal bytesSent As Integer,
ByVal bytesTotal As Integer) Handl es obj St pMil . OnProgress

Event processing code
End Sub

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included Visual Basic .NET samples provide code snapshots for common
operations such as sending text e-mails, sending HTML e-mails, adding attachments to e-mails,
creating HTML e-mails with embedded images.

2.4.2 Samples

AddEmail includes the following Visual Basic .NET samples:
SimpleSend Sample

Location: AddEmail\Samples\VB.NET 2002-2003\SimpleSend\
AddEmail\Samples\VB.NET 2005-2010\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

SimpleSendAttachment Sample

Location: AddEmail\Samples\VB.NET 2002-2003\SimpleSendAttachment\
AddEmail\Samples\VB.NET 2005-2010\SimpleSendAttachment\

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachment.

HtmIMail Sample

Location: AddEmail\Samples\VB.NET 2002-2003\HtmIMail\
AddEmail\Samples\VB.NET 2005-2010\HtmIMail\
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HtmIMail sample demonstrates how to send HTML e-mails with attachments using Send. This sample
also shows how to set alternative text-only body of e-mail.

ImportHtmIWithimages Sample

Location: AddEmail\Samples\VB.NET 2002-2003\ImportHtmIWithImages\
AddEmail\Samples\VB.NET 2005-2010\ImportHtmIWithImages\

ImportHtmIWithimages sample demonstrates how to import HTML file with embedded images using
ImportHTML.

Embeddedimages Sample

Location: AddEmail\Samples\VB.NET 2002-2003\EmbeddedIimages\
AddEmail\Samples\VB.NET 2005-2010\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

EnterpriseMail Sample

Location: AddEmail\Samples\VB.NET 2002-2003\EnterpriseMail\
AddEmail\Samples\VB.NET 2005-2010\EnterpriseMail\

EnterpriseMail sample demonstrates features of AddEmail Enterprise version. It shows how to queue
and send multiple e-mails simultaneously using AddEmail multi-threading support. This sample also
shows how to process events from SmtpMail object. In addition, this sample shows how to send e-
mails directly to recipients' mail servers without using outgoing mail server of your organization or
internet provider.

UnicodeMail Sample

Location: AddEmail\Samples\VB.NET 2002-2003\UnicodeMail\
AddEmail\Samples\VB.NET 2005-2010\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\VB.NET 2002-2003\SendAsync\
AddEmail\Samples\VB.NET 2005-2010\SendAsync\

HtmIMail sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync. This sample also shows how to process events from SmtpMail object.

2.5 VBA (Microsoft Office)
2.5.1 Using AddEmail in VBA projects

AddEmail ActiveX can be used to send emails from any Microsoft Office application that supports
Visual Basic for Applications (VBA), such as Microsoft Access, Microsoft Excel, Microsoft Word etc. To
use AddEmail in your VBA project perform the following steps:
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1. (Optional) Add reference to AddEmail library: In VBA editor menu, select Tools -> References. Find
and select AddEmail 3.0 Type Library.

2. Add a code that creates SmtpMail object and sends a message using SimpleSend,
SimpleSendHtml, SimpleSendAttachment or Send. Please use code snapshots below to get started.

Snapshot 1: simple text email.

Dim obj SmtpMail As oject, strError As String, nunResultCode As Long
Set obj SmtpMail = CreateQbject("AddEmail. Snt pMail")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj Smt pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj St pMai | . Si mpl eSend("j smit h@ryserver. cont',
"j ane@omneserver.com j anes@oneserver.cont', "test", "Test message", strError)
I f numResul t Code = 0 Then
MsgBox "Sent successfully!"
El se
MsgBox strError
End If

Snapshot 2: text email with attachments.

Dim obj SmtpMail As oject, strError As String, nunResultCode As Long
Set obj SmtpMail = CreateQbject("AddEmail. Snt pMail")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj St pMai | . Si npl eSendAtt achment ("] smit h@yserver. conf,
"j ane@oneserver.com j anes@oneserver.cont', "test", "Test nessage",
"c:\files\docl. pdf;c:\files\doc2. pdf", strError)
I f numResul t Code = 0 Then
MsgBox "Sent successfully!"
El se
MsgBox strError
End If

Snapshot 3: HTML message with attachments.

Dim obj SmtpMail As oject, strError As String, nunResultCode As Long

Set obj SmtpMail = CreateQbject("AddEmail. Snt pMail")

obj St pMai | . Snt pServer = "mail . nyserver. conf

obj Smt pMai | . Snt pUsername = "jsnith"

obj Smt pMai | . Snt pPassword = "nypasswor d”
Create nmessage and setup subject and body

Di m obj Mai | Message As bj ect

Set obj Mai | Message = Creat eObj ect (" AddEmai | . Mai | Message")

obj Mai | Message. MessageBodyFormat = 1 ' HTM. f or mat

obj Mai | Message. MessageSubj ect = "test"

obj Mai | Message. MessageBody = "<ht ml ><body><b>Test i ng. .. </ b></ body></ ht m >"

Add first attachnent
Di m obj Mai | Attachnent As Obj ect
Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\docl. pdf"
obj Mai | Message. AddAt t achnent obj Mai | Att achnent

Add second attachnent
Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\doc2. pdf"
obj Mai | Message. AddAt t achnent obj Mai | Att achnent

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



Samples and Tutorials 22

Set up sender
Di m obj Mai | Address As bj ect
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "John Smith"
obj Mai | Addr ess. Address = "jsnith@ryserver. cont
obj Mai | Message. Sender = obj Mai | Addr ess

Setup first recipient
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Jane Smith"
obj Mai | Addr ess. Address = "jane@oneserver. cont
obj Mai | Message. AddReci pi ent obj Mai | Addr ess

Setup second reci pi ent
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Janmes Snith"
obj Mai | Addr ess. Address = "j ames@oneserver. conf
obj Mai | Message. AddReci pi ent obj Mai | Addr ess

Send prepared nmessage
nunmResul t Code = obj Smt pMai | . Send( obj Mai | Message, True, strError)
I f numResul t Code = 0 Then
MsgBox "Sent successfully!"
El se
MsgBox strError
End If

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties.

2.5.2 Samples

AddEmail includes the following VBA samples:
SimpleSend Sample

Location: AddEmail\Samples\Access\SimpleSend.adp
AddEmail\Samples\Excel\SimpleSend.xlIs

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

HtmIMail Sample
Location: AddEmai\Samples\Access\HtmIMail.adp

HtmIMail sample demonstrates how to send HTML e-mails with attachments using Send. This sample
also shows how to set alternative text-only body of e-mail.

SendAsync Sample
Location: AddEmail\Samples\Access\SendAsync.adp

HtmIMail sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync. This sample also shows how to process events from SmtpMail object.
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2.6 VBScript
2.6.1 Using AddEmail in VBScript projects

AddEmail ActiveX can be used with any environment that supports VBScript. Windows has built-in
VBScript support and can execute VBScript files that have .VBS extension. To use AddEmail ActiveX
from VBScript code create SmtpMail object and send a message using SimpleSendScriptable,
SimpleSendAttachmentScriptable or SendScriptable. Please use code snapshots below to get started.

Snapshot 1: simple text email.

Di m obj Smt pMai |, strError, nunResul t Code
Set obj SmtpMail = CreateObject("AddEmail. Snt pMail")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj St pMai | . Si npl eSendScri pt abl e("j smit h@yserver. conf,
"j ane@oneserver.com j anes@oneserver.cont', "test", "Test message", strError)
I f nunmResul t Code = 0 Then
MsgBox "Sent successfully!"
El se
MsgBox strError
End |f

Snapshot 2: text email with attachments.

Di m obj SmtpMai |, strError, nunResul t Code
Set obj SmtpMail = CreateQbject("AddEmail. SntpMail")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj Smt pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj St pMai | . Si npl eSendAtt achnment Scri pt abl e("j sm t h@ryserver. cont',
"j ane@oneserver.com j anes@oneserver.cont', "test", "Test nessage",
"c:\files\docl. pdf;c:\files\doc2. pdf", strError)
I f numResul t Code = 0 Then
MsgBox "Sent successfully!"
El se
MsgBox strError
End If

Snapshot 3: HTML message with attachments.

Di m obj Snt pMai |, obj Mai | Message, obj Mai | Attachnent, obj Mail Address, strError,

nunResul t Code

Set obj SmtpMail = CreateQbject("AddEmail. SntpMail")

obj St pMai | . Snt pServer = "mai |l . nyserver. conf

obj St pMai | . Snt pUsername = "jsnith"

obj Smt pMai | . Snt pPassword = "nypasswor d”
Create nmessage and setup subject and body

Set obj Mai | Message = Creat eObj ect (" AddEmai | . Mai | Message")

obj Mai | Message. MessageBodyFormat = 1 ' HTM. f or mat

obj Mai | Message. MessageSubj ect = "test"

obj Mai | Message. MessageBody = "<ht ml ><body><b>Test i ng. .. </ b></ body></ ht m >"

Add first attachnent
Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\docl. pdf"
obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

Add second attachnent
Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\doc2. pdf"
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obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

Set up sender
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "John Smith"
obj Mai | Addr ess. Address = "jsnith@ryserver. cont
obj Mai | Message. Sender = obj Mai | Addr ess

Setup first recipient
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Jane Smith"
obj Mai | Addr ess. Address = "jane@oneserver. cont
obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

Setup second reci pi ent
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Janmes Snith"
obj Mai | Addr ess. Address = "james@oneserver. conf
obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

Send prepared nmessage
nunmResul t Code = obj St pMai | . SendScri pt abl e( obj Mai | Message, True, strError)
I f numResul t Code = 0 Then

MsgBox "Sent successfully!"

El se

MsgBox strError
End If

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included VBScript samples provide code snapshots for common operations
such as sending text e-mails, sending HTML e-mails, adding attachments to e-mails.

2.6.2 Samples

AddEmail includes the following VBScript samples:
SimpleSend Sample
Location: AddEmail\Samples\VBS\SimpleSend.vbs

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSendScriptable.

SimpleSendAttachment Sample
Location: AddEmail\Samples\VBS\SimpleSendAttachment.vbs

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachmentScriptable.

HtmIMail Sample
Location: AddEmail\Samples\VBS\HtmIMail.vbs

HtmIMail sample demonstrates how to send HTML e-mails with attachments synchronously using
SendScriptable. This sample also shows how to set alternative text-only body of e-mail.

ImportHtmIWithimages Sample
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2.7
2.7.1

Location: AddEmail\Samples\VBS\ImportHtmIWithimages\

ImportHtmIWithimages sample demonstrates how to import HTML file with embedded images using
ImportHTML.

Embeddedimages Sample
Location: AddEmail\Samples\VBS\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

JScript
Using AddEmail in JScript projects

AddEmail ActiveX can be used with any environment that supports JScript. Windows has built-in
JScript support and can execute JScript files that have .JS extension. To use AddEmail ActiveX from
JScript code create SmtpMail object and send a message using SimpleSendScriptable,
SimpleSendAttachmentScriptable or SendScriptable. Please use code snapshots below to get started.

Snapshot 1: simple text email.

var obj SntpMail, strError, nunResult Code;

obj Smt pMai |l = new ActiveXObj ect (" AddEmai | . Snt pMai |l ") ;

obj St pMai | . Snt pServer = "mail . nyserver. conf';

obj St pMai | . Snt pUsernanme = "jsnith";

obj Smt pMai | . Snt pPassword = "nypassword”;

nunmResul t Code = obj St pMai | . Si npl eSendScri pt abl e("j smit h@yserver. conf,
"jane@omneserver.com j anes@oneserver.cont', "test", "Test message", strError);
i f (nunResul t Code == 0)

WScri pt. Echo(" Sent successful [y!");

| se

A~ DY

strError = obj Snt pMai | . Get Last Error Descri ption();
WScri pt. Echo(strError);

Snapshot 2: text email with attachments.

var obj SntpMail, strError, nunResult Code;

obj Smt pMai |l = new ActiveXhj ect (" AddEnmai | . St pMai | ")

obj St pMai | . Snt pServer = "mail . nyserver. conf';

obj St pMai | . Snt pUsername = "jsnith";

obj Smt pMai | . Snt pPassword = "nypassword”;

nunmResul t Code = obj St pMai | . Si npl eSendAtt achment Scri pt abl e("j sm t h@ryserver. cont',
"j ane@oneserver.com j anes@oneserver.cont', "test", "Test nessage",
"c:\\files\\docl. pdf;c:\\files\\doc2. pdf", strError);

i f (nunResul t Code == 0)

WScri pt. Echo(" Sent successful [y!");

| se

A~ DY

strError = obj Snt pMai | . Get Last Error Descri ption();
WScri pt. Echo(strError);

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



Samples and Tutorials 26

Snapshot 3: HTML message with attachments.

var obj Snt pMai |, obj Mail Message, obj Mail Attachment, obj Mai | Address, strError,
nunResul t Code

obj Smt pMai |l = new ActiveXObj ect (" AddEmai | . Snt pMail ") ;

obj St pMai | . Snt pServer = "mail . nyserver. conf';

obj St pMai | . Snt pUsernanme = "jsnith";

obj Smt pMai | . Snt pPassword = "nypassword”;
obj St pMai | . Snt pSSL = f al se;

/'l Create nessage and setup subject and body

obj Mai | Message = new ActiveXObj ect (" AddEmmai | . Mai | Message") ;

obj Mai | Message. MessageBodyFormat = 1; //HTM. for mat

obj Mai | Message. MessageSubj ect = "test";

obj Mai | Message. MessageBody = "<htm ><body><b>Testi ng. .. </ b></body></ht ml >";

/1 Add first attachment

obj Mai | Attachnent = new ActiveXObj ect ("AddEmail. Mail Attachment");
obj Mai | Attachnent. File = "c:\\files\\docl. pdf";

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent) ;

/1 Add second attachment

obj Mai | Attachnent = new ActiveXObj ect ("AddEmail. Mail Attachment");
obj Mai | Attachnent.File = "c:\\files\\doc2. pdf";

obj Mai | Message. AddAt t achnent (obj Mai | Att achnment) ;

/'l Setup sender

obj Mai | Address = new ActiveXObj ect (" AddEmnmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "John Smith";

obj Mai | Addr ess. Address = "jsnith@ryserver. cont;

obj Mai | Message. Sender = obj Mai | Addr ess;

/'l Setup first recipient

obj Mai | Address = new ActiveXObj ect (" AddEmmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "Jane Smith";

obj Mai | Addr ess. Address = "jane@oneserver. cont;

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess) ;

/'l Setup second recipient

obj Mai | Address = new ActiveXObj ect (" AddEmmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "Janmes Snith";

obj Mai | Addr ess. Address = "james@oneserver. coni;

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess) ;

/1 Send prepared nessage synchronously
nunmResul t Code = obj St pMai | . SendScri pt abl e( obj Mai | Message, true, strError);
i f (nunResul t Code == 0)

{
WScri pt. Echo(" Sent successful [y!");

}

el se
strError = obj Snt pMai | . Get Last Error Descri ption();
WScri pt. Echo(strError);

}

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included JScript samples provide code snapshots for common operations
such as sending text e-mails, sending HTML e-mails, adding attachments to e-mails.
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2.7.2

2.8
28.1

Samples

AddEmail includes the following JScript samples:
SimpleSend Sample
Location: AddEmail\Samples\JS\SimpleSend.js

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSendScriptable.

SimpleSendAttachment Sample
Location: AddEmail\Samples\JS\SimpleSendAttachment.js

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachmentScriptable.

HtmIMail Sample
Location: AddEmail\Samples\JS\HtmIMail.js

HtmIMail sample demonstrates how to send HTML e-mails with attachments synchronously using
SendScriptable. This sample also shows how to set alternative text-only body of e-mail.

ImportHtmIWithimages Sample
Location: AddEmail\Samples\VBS\ImportHtmIWithimages\

ImportHtmIWithimages sample demonstrates how to import HTML file with embedded images using
ImportHTML.

Embeddedimages Sample
Location: AddEmail\Samples\VBS\Embeddedimages\

Embeddedimages sample demonstrates how to create and send HTML e-mails with embedded
images using Send.

ASP - VBScript

Using AddEmail in ASP / VBScript projects

To use AddEmail in your ASP / VBScript project perform the following steps:

1. (Optional) If you are using Visual Interdev add a reference to the AddEmail library: In Visual Interdev
main menu, select Project -> References. Find and select AddEmail 3.0 Type Library.

2. Declare variable that will hold a reference to the SmtpMail object:
Di m obj Snt pMai |

3a. Create an instance of the SmtpMail object:
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Set obj SmtpMail = Server. CreateObj ect (" AddEmai | . Snt pMai | ")

3b. If you are sending e-mails asynchronously you will need to access the same SmtpMail object on
more than one page. In this case store an instance of the SmtpMail object in Session collection:

If | sEnpty(Session("SntpMil")) Then

Set obj SmtpMail = Server. CreateObj ect (" AddEmai | . Snt pMai | ")
Set Session("SntpMil") = obj Smt pMai l

El se
Set obj SmtpMail = Session("SntpMil")

End If

4. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pPort = 25
obj Smt pMai | . Snt pUser nane
obj Smt pMai | . Snt pPasswor d

"jsmth"
"nypasswor d”

5a. Send an e-mail synchronously using SimpleSendScriptable or SimpleSendAttachmentScriptable:

Dinm strError, nunResul t Code

nunmResul t Code = obj St pMai | . Si npl eSendScri pt abl e("j smit h@yserver. conf,

"j ane@oneserver.com j anes@oneserver.cont', "test", "Test message", strError)

I f nunResul t Code = 0 Then
' The emmil was sent successfully
Response. Wite "Sent successfully!"

El se
' The emmil was not sent, strError contains error description
Response. Wite strError

End | f

5b. Alternatively, create and fill MailMessage object and send it synchronously using SendScriptable or
asynchronously using SendAsync:

Di m obj Mai | Message, obj Mail Attachnment, obj Mail Address, strError, nunResult Code
' Create nessage and setup subject and body

Set obj Mai | Message = Creat eObj ect (" AddEmai | . Mai | Message")

obj Mai | Message. MessageBodyFormat = 1 ' HTM. f or mat

obj Mai | Message. MessageSubj ect = "test"

obj Mai | Message. MessageBody = " <ht ml ><body><b>Test i ng. .. </ b></ body></ ht m >"

' Add first attachnment

Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\docl. pdf"

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

' Add second attachnent

Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\files\doc2. pdf"

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

' Setup sender

Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "John Smith"

obj Mai | Addr ess. Address = "jsnith@ryserver. cont

obj Mai | Message. Sender = obj Mai | Addr ess

' Setup first recipient

Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Jane Smith"

obj Mai | Addr ess. Address = "jane@oneserver. cont
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2.8.2

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

' Setup second recipient

Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")

obj Mai | Addr ess. Nane = "Janes Snith"

obj Mai | Addr ess. Address = "j ames@oneserver. conf

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

' Send prepared nessage synchronously

Dinm strError, nunResul t Code

nunResul t Code = obj Snt pMai | . SendScri pt abl e(obj Mai | Message, True, strError)

I f numResul t Code = 0 Then
' The emmil was sent successfully
Response. Wite "Sent successfully!"

El se
' The emmil was not sent, strError contains error description
Response. Wite strError

End If

' Alternatively, send prepared nessage asynchronously

' Di m nessageNunber

' messageNunber = obj Snt pMai | . SendAsync(obj Mai | Message, True)

' Save the message nunber. It is used to retrieve the status of the nessage

6. If the message was sent asynchronously use GetStatus to check the status of the message:

Di m nuntt at us
nunft at us = obj Snt pMai | . Get St at us( numvessageNunber)
Sel ect Case nunft at us
Case 0 ' Mail St at usQueued
Response. Wite "Queued"
Case 1 ' Mail StatusSendi ng
Response. Wite "Sending..."
Case 2 ' Mail St at usSent
Response. Wite "Sent successfully!"
Case 3 'Mail StatusFail ed
Response. Wite "Error " & obj Snt pMail . Get Error Code( numvessageNumnber)
Response. Wite "<BR>" & obj Snt pMai | . Get Error Descri pti on( nunvessageNunber)
Case 4 ' Mail St at usCancel ed
Response. Wite "Message cancel ed”
End Sel ect

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included ASP samples provide code snapshots for common operations such
as sending text e-mails and sending HTML e-mails.

Samples

AddEmail includes the following ASP / VBScript samples:
SimpleSend Sample
Location: AddEmail\Samples\ASP - VBScript\SimpleSend\

SimpleSend sample demonstrates how to send text ot HTML e-mails synchronously using SimpleSend
method.

HtmIMail Sample
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Location: AddEmail\Samples\ASP - VBScript\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails synchronously using SendScriptable
method. This sample also shows how to set alternative text-only body of e-mail.

UnicodeMail Sample
Location: AddEmail\Samples\ASP - VBScript\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample
Location: AddEmail\Samples\ASP - VBScript\SendAsync\

SendAsync sample demonstrates how to send HTML e-mails asynchronously using SendAsync
method. This sample also shows how to get status of the e-mail using GetStatus.

2.9 ASP - JScript
2.9.1 Using AddEmail in ASP / JScript projects

To use AddEmail in your ASP / JScript project perform the following steps:

1. (Optional) If you are using Visual Interdev add a reference to the AddEmail library: In Visual Interdev
main menu, select Project -> References. Find and select AddEmail 3.0 Type Library.

2. Declare variable that will hold a reference to the SmtpMail object:
var obj Snt pMai | ;

3a. Create an instance of the SmtpMail object:

obj Snt pMai |l = Server. Creat eObj ect ("AddEmai | . Snt pMai | ") ;

3b. If you are sending e-mails asynchronously you will need to access the same SmtpMail object on
more than one page. In this case store an instance of the SmtpMail object in Session collection:

if (Session("SntpMail") == null)

obj Snt pMai |l = Server. Creat eObj ect ("AddEmai | . Snt pMai | ") ;
Session("SntpMail") = obj St pMail;
}

el se

obj Snt pMai |l = Session("SntpMail");

4. Set SMTP server address, port, username and password:

obj Snt pMai | . Snt pServer = "mai |l . nyserver. conf';
obj Snt pMai | . Snt pPort = 25;

obj Snt pMai | . Snt pUser nane
obj Snt pMai | . Snt pPasswor d

"jsmth";
"nypassword”;
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5a. Send an e-mail synchronously using SimpleSendScriptable or SimpleSendAttachmentScriptable:

var strError, nunResul t Code;

nunmResul t Code = obj St pMai | . Si npl eSendScri pt abl e("j smit h@yserver. conf,
"jane@omneserver.com j anes@oneserver.cont', "test", "Test message", strError);
i f (nunResul t Code == 0)

/1 The email was sent successfully
Response. Wite("Sent successfully!");

}

el se
/1 The email was not sent, strError contains error description
strError = obj Snt pMai | . Get Last Error Descri ption();
Response. Wite(strError);

}

5b. Alternatively, create and fill MailMessage object and send it synchronously using SendScriptable or
asynchronously using SendAsync:

var obj Mai | Message, obj Mail Attachnent, obj Mail Address, strError, nunResult Code;

/'l Create nessage and setup subject and body

obj Mai | Message = new ActiveXObj ect (" AddEmai | . Mai | Message") ;

obj Mai | Message. MessageBodyFormat = 1; //HTM. for mat

obj Mai | Message. MessageSubj ect = "test";

obj Mai | Message. MessageBody = "<ht m ><body><b>Testi ng. .. </ b></body></ ht m >";

/1 Add first attachment

obj Mai | Attachnent = new ActiveXObj ect ("AddEmail. Mail Attachment");
obj Mai | Attachnent. File = "c:\\files\\docl. pdf";

obj Mai | Message. AddAt t achnent (obj Mai | Att achnment) ;

/1 Add second attachment

obj Mai | Attachnent = new ActiveXObj ect ("AddEmail. Mail Attachment");
obj Mai | Attachnent.File = "c:\\files\\doc2. pdf";

obj Mai | Message. AddAt t achnent (obj Mai | Att achnment) ;

/'l Setup sender

obj Mai | Address = new ActiveXObj ect (" AddEmmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "John Smith";

obj Mai | Addr ess. Address = "jsnith@ryserver. cont;

obj Mai | Message. Sender = obj Mai | Addr ess;

/'l Setup first recipient

obj Mai | Address = new ActiveXObj ect (" AddEmmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "Jane Smith";

obj Mai | Addr ess. Address = "jane@oneserver. cont;

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess) ;

/'l Setup second recipient

obj Mai | Address = new ActiveXObj ect (" AddEmmai | . Mai | Addr ess") ;
obj Mai | Addr ess. Nane = "Janmes Snith";

obj Mai | Addr ess. Address = "james@oneserver. coni;

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess) ;

/'l Send prepared nmessage synchronously
nunmResul t Code = obj Smt pMai | . SendScri pt abl e( obj Mai | Message, true, strError);
i f (nunResul t Code == 0)

/1 The email was sent successfully
Response. Wite("Sent successfully!");

}

el se

{
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/1 The email was not sent, strError contains error description
strError = obj Snt pMai | . Get Last Error Descri ption();
Response. Wite(strError);

/1 Alternatively, send prepared nessage asynchronously

/1l var nessageNunber;

/1 messageNunber = obj Snt pMai | . SendAsync(obj Mai | Message, true);

/1l Save the message nunber. It is used to retrieve the status of the nessage

6. If the message was sent asynchronously use GetStatus to check the status of the message:

var nunftt at us;
nunmtt at us = obj Smt pMai | . Get St at us( nunivessageNunber) ;
swi t ch( nunst at us)

{
case 0: //WMail StatusQueued

Response. Wite(" Qeued");
br eak;
case 1: // Mail StatusSendi ng
Response. Wite("Sending...");
br eak;
case 2: //Mail StatusSent
Response. Wite("Sent successfully!");
br eak;
case 3: //Mil StatusFail ed
Response. Wite("Error ");
Response. Wit e(obj St pMai | . Get Err or Code( nunmvessageNunber) ) ;
Response. Wite("<BR>");
Response. Wit e(obj Snt pMai | . Get Error Descri pti on( numvessageNunber));
br eak;
case 4: //Mil StatusCancel ed
Response. Wite "Message cancel ed”;
br eak;

}

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included ASP samples provide code snapshots for common operations such
as sending text e-mails and sending HTML e-mails.

2.9.2 Samples

AddEmail includes the following ASP / JScript samples:
SimpleSend Sample
Location: AddEmail\Samples\ASP - JScript\SimpleSend\

SimpleSend sample demonstrates how to send text ot HTML e-mails synchronously using
SimpleSend.

HtmIMail Sample
Location: AddEmail\Samples\ASP - JScript\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails synchronously using SendScriptable. This
sample also shows how to set alternative text-only body of e-mail.

UnicodeMail Sample
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Location: AddEmail\Samples\ASP - JScript\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\ASP - JScript\SendAsync\

SendAsync sample demonstrates how to send HTML e-mails asynchronously using SendAsync
method. This sample also shows how to get status of the e-mail using GetStatus.

2.10 ASP.NET -C#
2.10.1 Using AddEmail in ASP.NET / C# projects

To use AddEmail in your ASP.NET / C# project perform the following steps:

1. Add a reference to the AddEmail library: In Visual Studio main menu, select View -> Solution
Explorer to open Solution Explorer. Right-click on the project that will use AddEmail and select Add
Reference from the pop-up menu. Click COM tab, find and select AddEmail 3.0 Type Library, click
Select button then OK button.

2. Declare variable that will hold a reference to the SmtpMail object:
AddEnai | Li b. St pMai | O ass obj Snt pMai | ;

3a. Create an instance of the SmtpMail object:

obj Smt pMai |l = new AddEnmai | Li b. Snt pMai |  ass();

3b. If you are sending e-mails asynchronously you will need to access the same SmtpMail object on
more than one page. In this case store an instance of the SmtpMail object in Session collection:

if( Session["SntpMail"] == null )
obj Smt pMai | = new AddEnmai | Li b. Snt pMai |  ass();
Session["SntpMail "] = obj Smt pMai l ;

}

el se

obj Smt pMai | = (AddEmai | Li b. Snt pMai | Cl ass) Sessi on[ " St pMai |l "] ;

4. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "mail . nyserver. coni';
obj St pMai | . Snt pPort = 25;
obj St pMai | . Snt pUsernanme = "jsnith";

obj Smt pMai | . Snt pPassword = "nypassword”;

5a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

string strError;
int resultCode = obj SntpMil.SinpleSend("jsnth@ryserver.cont,
"j ane@oneserver.com janes@oneserver.cont', "test", "Test nessage", out strError);
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if (resultCode == 0)

/1 E-mail was sent successfully

}

el se

/1 Send failed, strError contains detailed error description

}

5b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
asynchronously using SendAsync:

/'l Create nessage and setup subject and body

Mai | MessageCl ass obj Message = new AddEnai | Li b. Mai | Messaged ass() ;
obj Message. MessageSubj ect = "test";

obj Message. MessageBody = "Test nessage”;

/'l Setup sender

Mai | Addr essCl ass obj Sender = new Mai | AddressC ass();
obj Sender . Address = "jsm th@ryserver. cont;

obj Sender. Nane = "Jane Snith";

obj Message. Sender = obj Sender;

/'l Setup first recipient

Mai | Addr essCl ass obj Reci pi ent = new Mai | AddressC ass();
obj Reci pi ent. Address = "jane@oneserver. coni;

obj Reci pi ent. Name = "Jane Smith";

obj Message. AddReci pi ent (obj Reci pi ent);

/'l Setup second recipient

obj Reci pi ent = new Mi | Addressd ass();

obj Reci pi ent. Address = "james@oneserver. cont;
obj Reci pi ent. Name = "Janes Snmith";

obj Message. AddReci pi ent (obj Reci pi ent);

/'l Send prepared nessage synchronously

string strError;

int resultCode = obj Snt pMail . Send(obj Message, true, out strError);
if (resultCode == 0)

/1 E-mail was sent successfully

}

el se

/1 Send failed, strError contains detailed error description

}

/1 Alternatively, send prepared nessage asynchronously
/1int messageNunber = obj Snt pMai | . SendAsync(obj Message, true);
/1l Save the message nunber. It is used to retrieve the status of the nessage

6. If the message was sent asynchronously use GetStatus to check the status of the message:

AddEnai | Li b. Mai | St at us nmessageSt at us = obj Snt pMai | . Get St at us( nessageNunber) ;
swi t ch(messagesSt at us)

{
case AddEnmi | Li b. Mai | St at us. Mai | St at usQueued:
br eak;
case AddEnail Li b. Mai | St at us. Mai | St at usSendi ng:
br eak;

case AddEmai |l Li b. Mai | St atus. Mai | St at usSent :
/1 E-mail was sent successfully

br eak;

case AddEmai |l Li b. Mai | St at us. Mai | St at usFai | ed:
/1 E-mail wasn't sent
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int errorCode = obj Smt pMi | . Get Er r or Code( messageNunber) ;

string errorDescription = obj SntpMil. GetErrorDescription(nessageNunber);
br eak;
case AddEmmi | Li b. Mai | St atus. Mai | St at usCancel ed:
br eak;

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included ASP.NET samples provide code snapshots for common operations
such as sending text e-mails and sending HTML e-mails.

Samples

AddEmail includes the following ASP.NET / C# samples:
SimpleSend Sample

Location: AddEmail\Samples\ASP.NET 1.x - C#\SimpleSend\
AddEmail\Samples\ASP.NET - C#\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

HtmIMail Sample

Location: AddEmai\Samples\ASP.NET 1.x - C#AHtmIMail\
AddEmail\Samples\ASP.NET - C#\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails synchronously using Send. This sample
also shows how to set alternative text-only body of e-mail.

UnicodeMail Sample

Location: AddEmail\Samples\ASP.NET 1.x - C#\UnicodeMail\
AddEmail\Samples\ASP.NET - C#\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\ASP.NET 1.x - C#\SendAsync\
AddEmail\Samples\ASP.NET - C#\SendAsync\

SendAsync sample demonstrates how to send HTML e-mails asynchronously using SendAsync. This
sample also shows how to get status of the e-mail using GetStatus.

ASP.NET - VB
Using AddEmail in ASP.NET / VB projects

To use AddEmail in your ASP.NET / VB project perform the following steps:
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1. Add a reference to the AddEmail library: In Visual Studio main menu, select View -> Solution
Explorer to open Solution Explorer. Right-click on the project that will use AddEmail and select Add
Reference from the pop-up menu. Click COM tab, find and select AddEmail 3.0 Type Library, click
Select button then OK button.

2. Declare variable that will hold a reference to the SmtpMail object:
Di m obj Snt pMai | As AddEmei | Li b. Snt pMai | C ass

3a. Create an instance of the SmtpMail object:

obj Smt pMai | = New AddEmmai | Li b. Snt pMai | d ass()

3b. If you are sending e-mails asynchronously you will need to access the same SmtpMail object on
more than one page. In this case store an instance of the SmtpMail object in Session collection:

If I sNothing(Session("SmtpMil")) Then

obj Smt pMai | = New AddEmmai | Li b. Snt pMai | d ass()
Session("SntpMail") = obj St pMai |

El se
obj Smt pMai |l = Sessi on("Snt pMail")

End If

4. Set SMTP server address, port, username and password:

obj St pMai | . Snt pServer = "mail . nyserver. conf
obj St pMai | . Snt pPort = 25
obj Smt pMai | . Snt pUser namne
obj Smt pMai | . Snt pPasswor d

"jsmth"
"nypasswor d”

5a. Send an e-mail synchronously using SimpleSend or SimpleSendAttachment:

Dim strError As String
Di m resul t Code As I|nteger
resul t Code = obj Snt pMai | . Si npl eSend("j sm t h@ryserver. cont',
"j ane@omneserver.com j anes@oneserver.cont', "test", "Test message", strError)
If resultCode = 0 Then
E-mai | was sent successfully
El se
Send failed, strError contains detailed error description
End | f

5b. Alternatively, create and fill MailMessage object and send it synchronously using Send or
asynchronously using SendAsync:

Create nmessage and setup subject and body
Di m obj Message As New AddEnmi | Li b. Mai | Messaged ass()
obj Message. MessageSubj ect = "test"
obj Message. MessageBody = "Test nessage"

Set up sender
Di m obj Sender As New AddEnai |l Li b. Mai | Addr essCl ass()
obj Sender . Address = "jsmi th@ryserver. conf
obj Sender. Nane = "John Smith"
obj Message. Sender = obj Sender

Setup first recipient
Di m obj Reci pi ent As AddEmai | Li b. Mai | Addr essCl ass
obj Reci pi ent = New AddEnai | Li b. Mai | Addr essCl ass()
obj Reci pi ent. Address = "jane@oneserver. conf
obj Reci pi ent. Namre = "Jane Smith"
obj Message. AddReci pi ent (obj Reci pi ent)
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Setup second reci pi ent
obj Reci pi ent = New AddEnai | Li b. Mai | Addr essCl ass()
obj Reci pi ent. Address = "james@oneserver. conf
obj Reci pi ent. Name = "Janes Smith"
obj Message. AddReci pi ent (obj Reci pi ent)

Send prepared nmessage synchronously
Dim strError As String
Di m resul t Code As I|nteger
resul t Code = obj Snt pMai | . Send( obj Message, True, strError)
If resultCode = 0 Then

' E-mail was sent successfully
El se

Send failed, strError contains detailed error description

End If

Al ternatively, send prepared nessage asynchronously
' Di m nessageNunber As | nteger
' messageNunber = obj Snt pMai | . SendAsync(obj Message, True)
Save the nessage nunmber. It is used to retrieve the status of the nessage

6. If the message was sent asynchronously use GetStatus to check the status of the message:

Di m messageSt at us As AddEmai | Li b. Mai | St at us
nessageSt at us = obj Smt pMai | . Get St at us( messageNunber)
Sel ect Case messageSt at us

Case AddEnmi | Li b. Mai | St at us. Mai | St at usQueued

Case. AddEmai I Li b. Mai | St at us. Mai | St at usSendi ng

Case AddEmmi | Li b. Mai | St at us. Mai | St at usSent

' E-mail was sent successfully
Case AddEmmi | Li b. Mai | St atus. Mai | St at usFai | ed

" E-nmail wasn't sent

Di m errorCode As I|nteger

error Code = obj Snt pMai | . Get Er r or Code( messageNunber)

Dim errorDescription As String

errorDescription = obj Snt pMai | . Get Error Descri pti on(nessageNunber)
Case AddEmmi | Li b. Mai | St atus. Mai | St at usCancel ed

End Sel eéi .
Please refer to the Reference section of this manual for detailed description of AddEmail objects,

methods and properties. Included ASP.NET samples provide code snapshots for common operations
such as sending text e-mails and sending HTML e-mails.

2.11.2 Samples

AddEmail includes the following ASP.NET / VB samples:
SimpleSend Sample

Location: AddEmai\Samples\ASP.NET 1.x - VB\SimpleSend\
AddEmail\Samples\ASP.NET - VB\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

HtmIMail Sample
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Location: AddEmail\Samples\ASP.NET 1.x - VB\HtmIMail\
AddEmail\Samples\ASP.NET - VB\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails synchronously using Send. This sample
also shows how to set alternative text-only body of e-mail.

UnicodeMail Sample

Location: AddEmail\Samples\ASP.NET 1.x - VB\UnicodeMail\
AddEmai\Samples\ASP.NET - VB\UnicodeMail\

UnicodeMail sample demonstrates how to create and send e-mails that contain Unicode characters.
Unicode can be used in the body of a message, in the subject field, and in the names of sender and
recipients.

SendAsync Sample

Location: AddEmail\Samples\ASP.NET 1.x - VB\SendAsync\
AddEmail\Samples\ASP.NET - VB\SendAsync\

SendAsync sample demonstrates how to send HTML e-mails asynchronously using SendAsync. This
sample also shows how to get status of the e-mail using GetStatus.

2.12 Delphi
2.12.1 Using AddEmail in Delphi projects

To use AddEmail in your Delphi project perform the following steps:
1. Import AddEmail ActiveX control.

If you have Delphi 2005 or later: In Delphi main menu, select File -> New -> Package - Delphi Win32.
Save the package as AddEmail_Package using File -> Save As menu. From Delphi main menu select
Component -> Import Component. Select 'Import ActiveX Control' and click Next. Find and select
AddEmail 3.0 Type Library, then click Add button. Click Next, make sure Palette Page is set to
ActiveX and click Next. Select 'Add unit to AddEmail_Package project' and click Finish. In the Project
Manager pane, right-click on AddEmail_Package and select Install. Delphi should display a message
confirming that the package is installed. After that AddEmail will be installed to the ActiveX tab of
Components palette.

If you have older version of Delphi: In Delphi main menu, select Components -> Import ActiveX
Control. Find and select AddEmail 3.0 Type Library, then click Install button. AddEmail ActiveX will be
installed to the ActiveX tab of Components palette.

2. Place SmtpMail object of AddEmail control on the form: Select ActiveX tab of Components palette,
click SmtpMail and drag a rectangle on the form. AddEmail control is not visible on runtime, so you can
place it anywhere on the form.

3. To process events from SmtpMail object, create event handlers: Click SmtpMail on the form and
select Events tab in the Object Inspector window. You will see 2 events OnProgress and
OnStatusChange. Double-click dropdown box next to event name to create event handler.

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties. Included Delphi samples provide code snapshots for common operations
such as sending text e-mails, sending HTML e-mails, adding attachments to e-mails and processing
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events.

Samples

AddEmail includes the following Delphi samples:
SimpleSend Sample
Location: AddEmail\Samples\Delphi 7\SimpleSend\

SimpleSend sample demonstrates how to send text or HTML e-mails synchronously using
SimpleSend.

SimpleSendAttachment Sample
Location: AddEmail\Samples\Delphi 7\SimpleSendAttachment\

SimpleSendAttachment sample demonstrates how to send text or HTML e-mails with attachments
synchronously using SimpleSendAttachment.

HtmIMail Sample
Location: AddEmail\Samples\Delphi 7\HtmIMail\

HtmIMail sample demonstrates how to send HTML e-mails with attachments synchronously using
Send method. This sample also shows how to set alternative text-only body of e-mail.

SendAsync Sample
Location: AddEmail\Samples\Delphi 7\SendAsync\

SendAsync sample demonstrates how to send HTML e-mails with attachments asynchronously using
SendAsync method. This sample also shows how to process events from SmtpMail object.

Visual FoxPro

Using AddEmail in FoxPro projects

AddEmail ActiveX can be used to send emails from Visual FoxPro applications. To use AddEmail in
your FoxPro project you need to add a code that creates SmtpMail object and sends a message using
SimpleSend, SimpleSendAttachment or Send. Please use code snapshots below to get started.

Snapshot 1: simple text email.

PRI VATE obj St pMai |, strError, nunmResult Code
obj Snt pMai | = CREATEOBJECT(" AddEmai | . Snt pMai | ")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj Smt pMai | . Snt pUser nane "jsmth"

obj Smt pMai | . Snt pPasswor d "nypasswor d”

strError = ""
nunmResul t Code = obj St pMai | . Si mpl eSend("j smi t h@ryserver. cont',
"j ane@oneserver.com james@oneserver.cont', "test", "Test message", @trError)

I F numResul t Code = 0 THEN
VESSAGEBOX( " Sent successful ly!")
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ELSE
VESSAGEBOX( strError)
ENDI F

Snapshot 2: text email with attachments.

PRI VATE obj St pMai |, strError, nunmResult Code
obj Snt pMai | = CREATEOBJECT(" AddEmai | . Snt pMai | ")
obj St pMai | . Snt pServer = "mail . nyserver. conf
obj Smt pMai | . Snt pUser nane "jsmth"

obj Smt pMai | . Snt pPasswor d "nypasswor d”

strError = ""
nunmResul t Code = obj St pMai | . Si npl eSendAtt achment ("j smit h@yserver. conf,
"j ane@omneserver.com j anes@oneserver.cont', "test", "Test nessage",

"c:\files\docl. pdf;c:\files\doc2. pdf", @trError)
I F nunResul t Code = 0 THEN
VESSAGEBOX( " Sent successful ly!")
ELSE
VESSAGEBOX( strError)
ENDI F

Snapshot 3: HTML message with attachments.

PRI VATE obj Snt pMai |, obj Mai | Message, obj Mai |l Attachnent, obj Mai | Addr ess
PRI VATE strError, nunResul t Code

obj Snt pMai | = CREATEOBJECT(" AddEmai | . Snt pMai | ")

obj St pMai | . Snt pServer = "mail . nyserver. conf

obj St pMai | . Snt pUsername = "jsnith"

obj Smt pMai | . Snt pPassword = "nypasswor d”
* Create nessage and setup subject and body

obj Mai | Message = CREATEOBJECT(" AddEmai | . Mai | Message")

obj Mai | Message. MessageBodyFormat = 1 && HTM. f or mat

obj Mai | Message. MessageSubj ect = "test"

obj Mai | Message. MessageBody = "<ht ml ><body><b>Test i ng. .. </ b></ body></ ht m >"

* Add first attachnent

obj Mai | Att achnent = CREATEOBJECT( " AddEnmil . Mai | Attachnment ")
obj Mai | Attachnent.File = "c:\files\docl. pdf"

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

* Add second attachnent

obj Mai | Att achnent = CREATEOBJECT( " AddEnmil . Mai | Attachnment ")
obj Mai | Attachnent.File = "c:\files\doc2. pdf"

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

* Setup sender

obj Mai | Addr ess = CREATEOBJECT(" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "John Smith"

obj Mai | Addr ess. Address = "jsnith@ryserver. cont

obj Mai | Message. Sender = obj Mai | Addr ess

* Setup first recipient

obj Mai | Addr ess = CREATEOBJECT(" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Jane Smith"

obj Mai | Addr ess. Address = "jane@oneserver. cont

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

* Setup second recipient

obj Mai | Addr ess = CREATEOBJECT(" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Nane = "Janmes Snith"

obj Mai | Addr ess. Address = "james@oneserver. conf

obj Mai | Message. AddReci pi ent (obj Mai | Addr ess)

* Send prepared nessage
nunmResul t Code = obj Smt pMai | . Send( obj Mai | Message, .t., @trError)
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I F numResul t Code = 0 THEN
VESSAGEBOX( " Sent successful ly!")
ELSE
VESSAGEBOX( strError)
ENDI F

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties.

PowerBuilder

Using AddEmail in PowerBuilder projects

AddEmail ActiveX can be used to send emails from PowerBuilder applications. To use AddEmail in
your PowerBuilder project you need to add a code that creates SmtpMail object and sends a message
using SimpleSend, SimpleSendAttachment or Send. Please use code snapshots below to get started.

Snapshot 1: simple text email.

OLEObj ect obj Snt pMai |
string strError
| ong nunResul t Code

obj Smt pMail = Create OLEObj ect
I f obj Snt pMai | . Connect ToNewChj ect (" AddEnai | . SmtpMail ") < O Then
Destroy obj Snt pMai |

MessageBox(" AddEmai | ", "Can't create AddEmmil. SntpMail COM object")
Ret urn

End If

obj St pMai | . Snt pServer = "mail . nyserver. conf

obj St pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj Smt pMai | . Si mpl eSend("j sm t h@ryserver. cont',

"jane@omneserver. com janmes@oneserver.cont, "test", "Test nmessage", Ref strError)
I f nunResul t Code = 0 Then
MessageBox(" AddEmai | ", "Sent successfully!")
El se
MessageBox( " AddEmai | ", strError)
End | f

Destroy obj Snt pMai |

Snapshot 2: text email with attachments.

OLEObj ect obj Snt pMai |
string strError
| ong nunResul t Code

obj Smt pMail = Create OLEObj ect
I f obj Snt pMai | . Connect ToNewChj ect (" AddEnai | . SmtpMail ") < O Then
Destroy obj Snt pMai |

MessageBox(" AddEmai | ", "Can't create AddEmmil. SntpMail COM object")
Ret urn

End If

obj St pMai | . Snt pServer = "mail . nyserver. conf

obj St pMai | . Snt pUsername = "jsnith"
obj Smt pMai | . Snt pPassword = "nypasswor d”
nunmResul t Code = obj Smt pMai | . Si npl eSendAt t achrent ("j smit h@ryserver. conf',
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"j ane@oneserver.com j ames@omneserver.cont, "test", "Test
"c:\files\docl. pdf;c:\files\doc2. pdf", Ref strError)
I f nunResul t Code = 0 Then
MessageBox (" AddEmmai | ",
El se
MessageBox (" AddEmmai | ",
End | f

Destroy obj Snt pMai |

nmessage",

"Sent successfully!")

strError)

Snapshot 2: HTML message with attachments.

OLEObj ect obj Snt pMai |,
string strError
| ong nunResul t Code

obj Mai | Message, obj Mail Attachrment, obj Mail Address

obj Smt pMail = Create OLEObj ect
I f obj Snt pMai | . Connect ToNewChj ect (" AddEnai | . SmtpMail ") < O Then
Destroy obj Snt pMai |

MessageBox(" AddEmai | ", "Can't create AddEmmil. SntpMail COM object")
Ret urn

End If

obj St pMai | . Snt pServer = "mail . nyserver. conf

obj Smt pMai | . Snt pUser nane
obj Smt pMai | . Snt pPasswor d

"jsmth"
"nypasswor d”
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obj Mai | Message
obj Mai | Message
obj Mai | Message
obj Mai | Message
obj Mai | Message

= Create OLEObj ect
. Connect ToNew(Cbj ect (" AddEmai | . Mai | Message")
. MessageBodyFormat = 1
. MessageSubj ect = "test"
. MessageBody = "<htm ><body><b>Testi ng. .. </ b></body></ht m >"

obj Mai | Attachnent = Create OLEODHj ect

obj Mai | At t achnent . Connect ToNewCbhj ect (" AddEnai | . Mai | Att achnment ")
obj Mai | Attachnent.File = "c:\files\docl. pdf"

obj Mai | Message. AddAt t achnent (obj Mai | Att achnent)

obj Mai | Attachnent = Create OLEODHj ect
obj Mai | At t achnent . Connect ToNewCbhj ect (" AddEnai | . Mai | Att achnment ")
obj Mai | Attachnent.File = "c:\files\doc2. pdf"

obj Mai | Message.

obj Mai | Addr ess

obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Message.

obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Message.

obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Addr ess.
obj Mai | Message.

nunResul t Code

I f nunmResul t Co
MessageBox

El se
MessageBox

End If

Destroy obj Smt

Destroy obj Mai

AddAt t achment (obj Mai | Att achment)

= Create OLEObj ect

Connect ToNewObj ect (" AddEmai | . Mai | Addr ess")
Nane = "John Smith"

Address = "jsmith@yserver. cont

Sender = obj Mai | Address

Connect ToNewObj ect (" AddEmai | . Mai | Addr ess")
Name = "Jane Smith"

Address = "jane@oneserver. cont

AddReci pi ent (obj Mai | Addr ess)

Connect ToNewObj ect (" AddEmai | . Mai | Addr ess")
Name = "Janes Smith"

Address = "james@oneserver. conf
AddReci pi ent (obj Mai | Addr ess)

= obj Snt pMai | . Send( obj Mai | Message,

True, Ref strError)

de = 0 Then

("AddEmmi | ", "Sent successfully!™)
("AddEmmi | ", strError)

pMai |

| Message
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Destroy obj Mai | Addr ess
Destroy obj Mai | Att achnent

Please refer to the Reference section of this manual for detailed description of AddEmail objects,
methods and properties.

Reference

SmtpMail

Overview

SmtpMail object is used to send messages, obtain status of messages, cancel delivery of messages
and set SMTP server parameters. SmtpMail object should remain in memory until all messages are
either delivered, canceled or failed. An application can create more than one instance of SmtpMail
object if it needs to.

Syntax:

[Visual Basic]

Di m obj Snt pMai | As New AddEnmi | Li b. Snt pMai |
obj Snt pMai | . Snt pServer = "mai |l . nyi sp. cont

[VBScript]

Di m obj Snt pMai |
Set obj SmtpMail = CreateQbject("AddEmail. SntpMail")
obj St pMai | . Snt pServer = "mai |l . nyi sp. cont’

[C#]

AddEnai | Li b. Snt pMai | O ass obj Snt pMai | = new AddEmai | Li b. Snt pMai | O ass() ;
obj St pMai | . Snt pServer = "mai |l . nyi sp. cont';

[C++]

AddEnai | Li b:: 1 Snt pMai | Ptr spSnt pMai | ;
spSnt pMai | . Creat el nst ance( __uui dof (AddEmmai | Li b: : Snt pMai | ));
spSmt pMai | - >Put Snt pServer ("mai | . nyi sp. con') ;

Properties:
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SmtpServer Name or IP address of the SMTP server to use for sending e-mail
messages.

SmtpPort Port number on the SMTP server.

SmtpUsername User name (account name) on the SMTP server.

SmtpPassword Password on the SMTP server.

SmtpSSL Specifies whether SMTP server requires an encrypted connection
(TLS/SSL).

SmtpSPA Specifies whether to use Secure Password Authentication (SPA).

MaxThreads Maximum number of mail sending threads.

SerialNumber

Serial number to activate purchased copy of AddEmail.

SenderHostname Fully-qualified hostname of the computer that sends the e-mails.
ConnectAttempts Number of connect attempts before reporting connection error.
ReplyTimeout Number of seconds to wait for a response from SMTP server before

reporting timeout error.

OnStatusChangeHandler

Handler for the OnStatusChange event.

OnProgressHandler

Handler for the OnProgress event.

Methods:

SimpleSend

Sends simple text or HTML e-mail message synchronously.

SimpleSendAttachment

Sends simple text or HTML e-mail message with attachments
synchronously.

SimpleSendHtml| Imports HTML file and sends HTML e-mail with embedded images
synchronously.

Send Sends e-mail message synchronously.

SendAsync Sends e-mail message asynchronously.

GetStatus Returns status of e-mail message.

GetErrorCode Returns error code of failed e-mail message.

GetErrorDescription

Returns error description of failed e-mail message.

Cancel Cancels sending of queued e-mail message.
CancelAll Cancels all queued e-mail messages.
GetlLastErrorCode Returns error code of the last synchronous send operation.

GetlLastErrorDescription

Returns error description of the last synchronous send operation.

GetQueueSize

Returns number of e-mail messages queued for sending.

Events:
OnStatusChange Notifies of message status changes.
OnProgress Notifies of message sending progress.
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3.1.2 SmtpServer Property

SmtpServer property specifies name or IP address of the outgoing mail server (SMTP server) to use
for sending e-mail messages.

Syntax

[Visual Basic]

obj Snt pMai | . Snt pSer ver "mail . nyi sp. cont’

[VBScript]

obj Smt pMai | . Snt pSer ver “mail . nyi sp. cont

[C#]

obj Snt pMai | . Snt pSer ver "mail . nyi sp. cont';

[C++]

HRESULT get _Snt pServer (BSTR*) ;
HRESULT put _Smt pServer (BSTR);

spSmt pMai | - >Put Snt pServer ("mai | . nyi sp. cont') ;

Remarks
SmtpServer property can be empty if messages are to be sent directly, without using outgoing mail

server (AddEmail Enterprise version only). Please refer to Send Method, SendAsync Method and
EnterpriseMail sample for details.

3.1.3 SmtpPort Property

SmtpPort property specifies port number on the outgoing mail server.
Syntax

[Visual Basic]

obj St pMai | . Snt pPort = 25
[VBScript]
obj Snt pMai | . Snt pPort = 25

[C#]

obj St pMai | . Snt pPort = 25;

[C++]

HRESULT get _Smt pPort (LONG) ;
HRESULT put _Snt pPort (LONG) ;
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spSmt pMai | - >Put Snt pPor t (25) ;

Remarks

Default value of SmtpPort property is 25 and doesn't have to be changed for most SMTP servers. If
port 25 doesn't work, please ask your network administrator or internet service provider what port
should be used to send e-mails.

3.1.4 SmtpUsername Property

SmtpUsername property specifies username (login or account name) on the outgoing mail server.
Syntax

[Visual Basic]

obj St pMai | . Snt pUsername = "smithj"

[VBScript]

obj Snt pMai | . Snt pUsernanme = "smithj"

[C#]

obj Snt pMai | . St pUsername = "smithj";

[C++]

HRESULT get _Smt pUser nane( BSTR*) ;
HRESULT put _Smt pUser nane( BSTR) ;

spSnt pMai | - >Put Snt pUser nane("smthj");

Remarks

SmtpUsername property contains empty string by default. This property should be set to an empty
string if your outgoing mail server doesn't require authentication.

3.1.5 SmtpPassword Property

SmtpPassword property specifies password on the outgoing mail server.
Syntax

[Visual Basic]

obj Snt pMai | . Snt pPassword = "pass"

[VBScript]

obj Smt pMai | . Snt pPassword = "pass”

[C#]
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obj Smt pMai | . Snt pPassword = "pass”;

[C++]

HRESULT get _Smt pPasswor d( BSTR*) ;
HRESULT put _Smt pPasswor d( BSTR) ;

spSnt pMai | - >Put Snt pPasswor d( " pass") ;

Remarks

SmtpPassword property contains empty string by default. This property should be set to an empty
string if your outgoing mail server doesn't require authentication.

3.1.6 SmtpSSL Property

SmtpSSL property specifies whether outgoing mail server requires an encrypted connection
(TLS/SSL).

Syntax

[Visual Basic]

obj Snt pMai | . Snt pSSL

True

[VBScript]

obj St pMai | . Snt pSSL = True

[C#]

obj Snt pMai | . Snt pSSL true;

[C++]

HRESULT get _Snt pSSL( VARl ANT_BOOL*) ;
HRESULT put _Snt pSSL( VARI ANT_BOOL) ;

spSmt pMai | - >Put Snt pSSL( VARI ANT_TRUE) ;

Remarks

SmtpSSL property is False by default. Set SmtpSSL property to True if you want to use TLS/SSL
connection, for example when using smtp.gmail.com server on port 465.

3.1.7 SmtpSPA Property

SmtpSPA property specifies whether to use Secure Password Authentication (SPA) method. SPA is
supported by Microsoft Exchange, Windows 2000 Server and Windows 2003 Server.

Syntax

[Visual Basic]
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obj Snt pMai | . Snt pSPA = True
[VBScript]

obj Smt pMai | . Snt pSPA = True
[C#]

obj Snt pMai | . Snt pSPA = true;

[C++]

HRESULT get _Snt pSPA( VARI ANT_BOOL*) ;
HRESULT put _Snt pSPA( VARI ANT_BOOL) ;

spSmt pMai | - >Put Snt pSPA( VARI ANT_TRUE) ;

Remarks
SmtpSPA property is False by default. If your outgoing mail server requires SPA please set SmtpSPA

property to True in order to use Secure Password Authentication. Please note that some servers are
configured to require SmtpUsername in username@domain.com format for SPA authentication.

3.1.8 MaxThreads Property

MaxThreads property specifies the maximum number of threads that SmtpMail object can create
when sending messages asynchronously using SendAsync (Enterprise version only).

Syntax

[Visual Basic]

obj Smt pMai | . MaxThreads = 10
[VBScript]
obj Snt pMai | . MaxThreads = 10

[C#]

obj Smt pMai | . MaxThr eads = 10;

[C++]

HRESULT get MaxThr eads(LONG") ;
HRESULT put _MaxThreads(LONG) ;

spSnt pMai | - >Put MaxThr eads( 10) ;

Remarks

Default value of MaxThreads property is 5, accepted range is 1 - 1000. AddEmail supports
simultaneous sending of several messages. This feature is useful if application has to send a large
number of messages, especially if messages are sent directly without using outgoing mail server.
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3.1.9

3.1.10

SmtpMail object creates one or more worker threads that send messages from its message queue.
MaxThreads property limits the number of threads that are running at the same time, therefore setting
the limit on the number of simultaneously transferred messages. MaxThreads property is available
only in AddEmail Enterprise version. AddEmail Professional always uses one thread to send
messages.

SenderHostname Property

Use SenderHostname property to specify fully-qualified hostname of the computer that sends e-mail
messages (Enterprise version only). SenderHostname is used when AddEmail sends e-mails directly
without using SMTP server of your organization or internet provider. Please see remarks for more
information.

Syntax

[Visual Basic]

obj Smt pMai | . Sender Host nane = "nmyserver. nydomai n. conf’

[VBScript]

obj Snt pMai | . Sender Host nane = "nyserver. nydomai n. cont

[C#]

obj St pMai | . Sender Host nane = "nyserver. nydomai n. cont';

[C++]

HRESULT get _Sender Host nane( BSTR*) ;
HRESULT put _Sender Host nane(BSTR) ;

spSnt pMai | - >Put Sender Host name( " myser ver . nydomai n. cont') ;

Remarks

SenderHostname property should be set to the fully-qualified hostname of the computer that sends e-
mail messages, for example myserver.mydomain.com. SenderHostname is transmitted to the
recipient's mail server when AddEmail sends e-mail messages directly. Some mail servers do not
accept incoming mail if SenderHostname is not set. In addition, some mail servers check reverse
DNS entry for the IP address of the computer that sends e-mail messages directly and verify that it
matches with the SenderHostname. Use the following link to check reverse DNS entry for an IP
address: http://postmaster.info.aol.com/tools/rdns.html

SimpleSend Method

SimpleSend method sends simple text or HTML e-mail to one or more recipients synchronously.
Syntax

[Visual Basic]

Function SinpleSend(strFrom As String, strTo As String, strSubject As String,
strMessage As String, ByRef strError As String) As Long
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Example:

Dim strError As String

Di m nunmResul t Code As Long

nunResul t Code = obj St pMai | . Si npl eSend(" My Nane <nme@yi sp. cond", "Soneone
<soneone@omnei sp. conmp; soneoneel se@oneot heri sp. conf’, "test", "Test nessage”,
strError)

[VBScript]

Function Sinpl eSendScri ptabl e(strFrom strTo, strSubject, strMessage, ByRef
strError)

Example:

Dim strError

Di m nunResul t Code

nunmResul t Code = obj St pMai | . Si npl eSendScri pt abl e("My Nane <ne@yi sp. comr®", "Soneone
<soneone@onei sp. conP; soneoneel se@oneot heri sp.cont', "test", "Test nessage",
strError)

[C#]

int SinpleSend(string strFrom string strTo, string strSubject, string strMessage,
out string strError);

Example:

string strError;

i nt nunResul t Code = obj Snt pMai | . Si npl eSend(" My Name <nme@ryi sp. com®”, " Sonmeone
<sonmeone@omnei sp. conr; soneoneel se@oneot heri sp. conf', "test", "Test nessage", out
strError);

[C++]

HRESULT Si npl eSend(BSTR strFrom BSTR strTo, BSTR strSubject, BSTR strMessage, BSTR*
pstrError, LONG* pnunResul t Code);

Example:

BSTR bstr;

int nunResul t Code = spSnt pMai | ->Si npl eSend("My Nane <ne@yi sp. con®", "Soneone
<sonmeone@onei sp. conP; soneoneel se@oneot heri sp. conf', "test", "Test nessage", &bstr);

_bstr_t strError(bstr, FALSE);

Parameters

strFrom [in]
Sender's e-mail address. You can also specify sender's name followed by the sender's e-mail address
in angled brackets.

strTo [in]
List of recipients' e-mail addresses separated by semicolon. You can also specify recipient's name
followed by the recipient's e-mail address in angled brackets.

strSubject [in]
Subject of the e-mail message.

strMessage [in]
Body of the e-mail message.
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3.1.11

strError [out]
Contains extended error information if the message failed to be sent, empty string otherwise.

Return value

Returns numeric result:
0 if the message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks

SimpleSend can be used to send text or HTML e-mails. Body of the e-mail message should start with
<html> tag for HTML e-mail messages. This method supports Unicode in the subject and body of the
message as well as in the sender's and recipients’ names. AddEmail will create Unicode e-mail (UTF-8
encoding) if any part of the message contains Unicode characters.

This method is synchronous: it returns after the message was sent or after an error occuried. Please
use it with care because single-threaded applications are blocked and can't process user input for the

duration of the SimpleSend call. Please refer to SendAsync Method if you want to send messages
without blocking your application.

SimpleSendAttachment Method

SimpleSendAttachment method sends simple text or HTML e-mail with attachments to one or more
recipients synchronously.

Syntax

[Visual Basic]

Function Sinpl eSendAttachnent (strFrom As String, strTo As String, strSubject As
String, strMessage As String, strAttach As String, ByRef strError As String) As Long

Example:

Dim strError As String

Di m numResul t Code As Long

nunmResul t Code = obj St pMai | . Si npl eSendAtt achment (" My Nanme <me@yi sp. comrs", " Soneone
<soneone@omnei sp. conmp; soneoneel se@oneot heri sp. cont’, "test", "Test nessage”,
"c:\files\docl. pdf;c:\files\doc2. pdf", strError)

[VBScript]

Functi on Si npl eSendAttachnent Scri ptabl e(strFrom strTo, strSubject, strMssage,
strAttach, ByRef strError)

Example:

Dinm strError

Di m nunResul t Code

nunmResul t Code = obj St pMai | . Si npl eSendAtt achment Scri pt abl e("My Nane <nme@yi sp. cons",
"Sonmeone <someone@onei sp. conP; soneoneel se@oneot heri sp. cont', "test", "Test
nessage", "c:\files\docl.pdf;c:\files\doc2.pdf", strError)

[C#]

int SinpleSendAttachment(string strFrom string strTo, string strSubject, string
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strMessage, string strAttach, out string strError);

Example:

string strError;

i nt numResul t Code = obj Smt pMai | . Si npl eSendAtt achment (" My Nanme <me@ryi sp. coms",
" Sonmeone <someone@onei sp. conp; someoneel se@oneot heri sp. cont', "test", "Test
nmessage", "c:\\files\\docl. pdf;c:\\files\\doc2.pdf", out strError);

[C++]

HRESULT Si npl eSendAttachnent (BSTR strFrom BSTR strTo, BSTR strSubject, BSTR
strMessage, BSTR strAttach, BSTR* pstrError, LONG* pnunResul t Code);

Example:

BSTR bstr;

i nt nunResul t Code = spSnt pMai | - >Si npl eSendAtt achrment ("My Nane <ne@ryi sp. conp",
"Sonmeone <someone@onei sp. conP; soneoneel se@oneot heri sp. cont', "test", "Test

nessage", "c:\\files\\docl. pdf;c:\\files\\doc2.pdf", &bstr);
_bstr_t strError(bstr, FALSE);

Parameters

strFrom [in]
Sender's e-mail address. You can also specify sender's name followed by the sender's e-mail address
in angled brackets.

strTo [in]
List of recipients' e-mail addresses separated by semicolon. You can also specify recipient's name
followed by the recipient's e-mail address in angled brackets.

strSubject [in]
Subject of the e-mail message.

strMessage [in]
Body of the e-mail message.

strAttach [in]
List of attachments separated by semicolon.

strError [out]
Contains extended error information if the message failed to be sent, empty string otherwise.

Return value

Returns numeric result:
0 if the message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks

SimpleSendAttachment can be used to send text or HTML e-mails. Body of the e-mail message
should start with <html> tag for HTML e-mail messages. This method supports Unicode in the subject
and body of the message as well as in the sender's and recipients' names. AddEmail will create
Unicode e-mail (UTF-8 encoding) if any part of the message contains Unicode characters.

This method is synchronous: it returns after the message was sent or after an error occuried. Please
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use it with care because single-threaded applications are blocked and can't process user input for the
duration of the SimpleSendAttachment call. Please refer to SendAsync Method if you want to send
messages without blocking your application.

3.1.12 SimpleSendHtml| Method

SimpleSendHtml method imports HTML file from disk and sends HTML e-mail with embedded
images to one or more recipients synchronously.

Syntax

[Visual Basic]

Function SinpleSendHtm (strFrom As String, strTo As String, strSubject As String,
strHHmM File As String, ByRef strError As String) As Long

Example:

Dim strError As String

Di m nunmResul t Code As Long

nunResul t Code = obj St pMai | . Si npl eSendHt M (" My Name <me@ryi sp. com®”, " Sonmeone
<soneone@onei sp. conr; soneoneel se@oneot heri sp. cont’, "test", "c:\files\email.htm",
strError)

[VBScript]

Function Sinpl eSendHt m Scri ptabl e(strFrom strTo, strSubject, strHm File, ByRef
strError)

Example:

Dinm strError

Di m nunResul t Code

nunmResul t Code = obj St pMai | . Si npl eSendHt m Scri pt abl e("My Nane <nme@yi sp. com",
"Sonmeone <someone@onei sp. conP; soneoneel se@oneot heri sp. cont', "test",
"c:\files\email.htm", strError)

[C#]

int SinpleSendHtm (string strFrom string strTo, string strSubject, string
strHtm File, out string strError);

Example:

string strError;
i nt nunmResul t Code = obj Smt pMai | . Si npl eSendHt M (" My Nane <ne@ryi sp. cons", "Soneone

<soneone@onei sp. com; soneoneel se@oneot heri sp. coni’, "test"”,
"c:\\files\\email.htm ", out strError);
[C++]

HRESULT Si npl eSendHt ml (BSTR strFrom BSTR strTo, BSTR strSubject, BSTR strHtm File,
BSTR* pstrError, LONG pnunResul t Code);

Example:

BSTR bstr;

int nunResul t Code = spSnt pMai | ->Si npl eSendHt Ml ("My Nane <nme@yi sp. con»", "Soneone
<soneone@onei sp. conP; soneoneel se@oneot heri sp. conf’, "test",
"c:\\files\\email.htm", &bstr);
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_bstr_t strError(bstr, FALSE);

Parameters

strFrom [in]
Sender's e-mail address. You can also specify sender's name followed by the sender's e-mail address
in angled brackets.

strTo [in]
List of recipients' e-mail addresses separated by semicolon. You can also specify recipient's name
followed by the recipient's e-mail address in angled brackets.

strSubject [in]
Subject of the e-mail message.

strFileName [in]
Filename of the HTML file to be imported.

strError [out]
Contains extended error information if the message failed to be sent, empty string otherwise.

Return value

Returns numeric result:
0 if the message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks

SimpleSendHtml can be used to send HTML e-mails with embedded images. This method imports
specified HTML file, adds all images referenced in the HTML as inline attachments and modifies HTML
as needed. Only images located on disk are added as attachments. Images from the web (http:// or
https:// links in HTML) are not attached. Please note that the current version of AddEmail does not
import images specified in CSS using url values.

This method supports Unicode in the subject and body of the message as well as in the sender's and
recipients' names. Please make sure HTML file uses UTF-8 encoding if you want to use Unicode.
AddEmail will create Unicode e-mail (UTF-8 encoding) if any part of the message contains Unicode
characters.

This method is synchronous: it returns after the message was sent or after an error occuried. Please
use it with care because single-threaded applications are blocked and can't process user input for the

duration of the SimpleSend call. Please refer to SendAsync Method if you want to send messages
without blocking your application.

3.1.13 SerialNumber Property

SerialNumber property specifies serial number to activate purchased copy of AddEmail.
Syntax

[Visual Basic]

obj Snt pMai | . Seri al Nunber = "12345-67890- ABCDE- EFCGH"
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[VBScript]

obj Snt pMai | . Seri al Nunber "12345- 67890- ABCDE- EFGH"

[C#]

obj Snt pMai | . Seri al Nunber = "12345-67890- ABCDE- EFGH";

[C++]

HRESULT get _Seri al Nunber ( BSTR*) ;
HRESULT put _Seri al Nunmber ( BSTR) ;

spSnt pMai | - >Put Seri al Nunber (" 12345- 67890- ABCDE- EFGH" ) ;

Remarks
SerialNumber property contains an empty string by default. After purchasing AddEmail you will receive

serial number needed to activate AddEmail. Set SerialNumber property to the serial number you
received.

3.1.14 ConnectAttempts Property

ConnectAttempts specifies how many times AddEmail will try to connect to the outgoing mail server
before returning connection error.

Syntax

[Visual Basic]

obj Snt pMai | . Connect Attenpts = 1
[VBScript]

obj St pMai | . Connect Attenpts = 1
[C#]

obj Snt pMai | . Connect Attenpts = 1;

[C++]

HRESULT get _Connect Att enpt s(LONG") ;
HRESULT put _Connect Att enpt s(LONG ;

spSmt pMai | - >Put Connect Att enpt s(1);

Remarks

Default value of ConnectAttempts property is 2. To send an e-mail, AddEmail connects to the
outgoing mail server specified in SmtpServer property. If connection could not be established,
AddEmail will make ConnectAttempts attempts to connect before giving up and reporting connection
error. If the server is down and does not respond, each connect attempt takes 20-30 seconds. You
might want to set ConnectAttempts to 1 if you are sending e-mails directly without using SMTP server
in order to speed up sending.
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3.1.15 ReplyTimeout Property

ReplyTimeout specifies how many seconds AddEmail will wait for a reply from the outgoing mail
server before returning timeout error.

Syntax

[Visual Basic]

obj Snt pMai | . Repl yTi neout = 20

[VBScript]

obj Smt pMai | . Repl yTi meout 20

[C#]

obj Snt pMai | . Repl yTi neout = 20;

[C++]

HRESULT get _Repl yTi meout (LONG") ;
HRESULT put _Repl yTi meout (LONG) ;

spSmnt pMai | - >Put Repl yTi meout (20) ;

Remarks

Default value of ReplyTimeout property is 30. To send an e-mail, AddEmail sends SMTP commands
to the outgoing mail server specified in SmtpServer property. After each sent command AddEmail will
wait up to ReplyTimeout seconds for a reply from the server. If the server does not respond within
specified ReplyTimeout, connection to the server is terminated and timeout error is reported. You

might want to set ReplyTimeout to 60-120 seconds if your outgoing mail server is slow and you get
timeout errors with the default value.

3.1.16 Send Method

Send method sends e-mail message synchronously.
Syntax

[Visual Basic]

Functi on Send(obj Message As AddEnmil Li b. Mai | Message, bUseSnt pServer As Bool ean,
ByRef strError As String) As Long

Example:
Dim strError As String

Di m nunResul t Code As Long
nunmResul t Code = obj St pMai | . Send( obj Message, True, strError)

[VBScript]
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Function SendScri pt abl e( obj Message, bUseSnt pServer, ByRef strError)

Example:
Dim strError

Di m nunResul t Code
nunmResul t Code = obj Smt pMai | . SendScri pt abl e( obj Message, True, strError)

[C#]

int Send(AddEmmi | Li b. Mai | Messaged ass obj Message, bool bUseSnt pServer, out string
strError);

Example:

string strError;
i nt nunResul t Code = obj Snt pMai | . Send(obj Message, true, out strError);

[C++]

HRESULT Send( | Mai | Message* obj Message, VARI ANT_BOCL bUseSnt pServer, BSTR* pstrError,
LONG* pnunResul t Code) ;

Example:

BSTR bstr;
i nt nunResul t Code = spSnt pMai | - >Send( obj Message, TRUE, &bstr);
_bstr_t strError(bstr, FALSE);

Parameters

obj Message [in]
Prepared MailMessage object containing the e-mail message to send.

bUseSnt pServer [in]

Specifies whether the message should be sent using SMTP server. If the parameter is true (not equal
to zero) message will be send using SMTP server specified in SmtpServer property. If the parameter is
false (equal to zero) message will be send directly to the recipients' mail server(s). This parameter is
valid for AddEmail Enterprise version only. AddEmail Professional always uses specified SMTP server.

strError [out]
Contains extended error information if the message failed to be sent, empty string otherwise.

Return value

Returns numeric result:
0 if message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks

This method is synchronous: it returns after the message was sent or after an error occuried. Please
use it with care because single-threaded applications are blocked and can't process user input for the
duration of Send call. Please refer to SendAsync Method if you want to send messages without
blocking your application. Please refer to the SenderHostname topic for more information about
sending e-mails directly without using SMTP server of your organization or internet provider (Enterprise
version only).
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3.1.17 SendAsync Method

SendAsync method sends e-mail message asynchronously.
Syntax

[Visual Basic]

Functi on SendAsync(obj Message As AddEnmil Li b. Mai | Message, bUseSnt pServer As Bool ean)
As Long

Example:

Di m numvessageNunber As Long
numvessageNunber = obj St pMai | . SendAsync(obj Message, True)

[VBScript]

Functi on SendAsync(obj Message, bUseSnt pServer)

Example:

Di m numvessageNunber
numvessageNurber = obj St pMai | . SendAsync( obj Message, True)

[C#]

i nt SendAsync( AddEnai | Li b. Mai | MessageCl ass obj Message, bool bUseSnt pServer);

Example:

i nt numvessageNunber = obj Smt pMai | . SendAsync(obj Message, true);

[C++]

HRESULT SendAsync(| Mai | Message* obj Message, VARI ANT_BOOL bUseSnt pServer, LONG
pnunResul t Code) ;

Example:

i nt numvessageNunber = spSnt pMai | - >SendAsync( obj Message, TRUE);

Parameters

obj Message [in]
Prepared MailMessage object containing the e-mail message to send.

bUseSnt pServer [in]

Specifies whether the message should be sent using SMTP server. If the parameter is true (not equal
to zero), message will be send using SMTP server specified in SmtpServer property. If the parameter
is false (equal to zero), message will be send directly to the recipients' mail server(s). This parameter is
valid for AddEmail Enterprise version only. AddEmail Professional always uses specified SMTP server.

Return value

Returns message number which identifies this message. Message number is used to obtain status of
the message or cancel the message.

Remarks
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3.1.18

This method is asynchronous: it validates the message, places it to the message queue and returns
immediately. Actual sending of the message is done in another thread. SendAsync doesn't block an
application and can be safely used in single-threaded applications. The message number returned by
this method is used in GetStatus Method, GetErrorCode Method, GetErrorDescription Method, Cancel
Method, OnStatusChange Event and OnProgress Event. Please refer to the SenderHostname topic for
more information about sending e-mails directly without using SMTP server of your organization or
internet provider (Enterprise version only).

GetStatus Method

GetStatus method obtains status of a message that was queued for sending using SendAsync
method.

Syntax

[Visual Basic]

Function GCet St at us(nunvessageNunber As Long) As AddEmai |l Li b. Mai | St at us

Example:

Di m messageSt at us As AddEmai | Li b. Mai | St at us
nmessageSt at us = obj St pMai | . Get St at us( nunmvessageNunber)

[VBScript]

Functi on Get St at us( numvessageNunber)

Example:

D m messageSt at us
nessageSt at us = obj St pMai | . Get St at us( nunmvessageNunber)

[C#]

AddEnai | Li b. Mai | Status Get St atus(i nt numvVessageNumnber) ;

Example:

AddEnai | Li b. Mai | St at us nmessageSt at us = obj Snt pMai | . Get St at us( humvessageNunber) ;

[C++]

HRESULT Get St at us(LONG nunMVessageNunber, Mail Status* pnessageSt at us) ;

Example:

AddEnai | Li b: : Mai | Status nessageStatus = spSnt pMai | - >Get St at us( numvessageNunber) ;

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

Return value

Returns status of the e-mail message. Message status values are defined in MailStatus enumeration.
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Remarks

SendAsync method places a message into a message queue and returns message number which
identifies the message. Use GetStatus method to obtain information about a status of the message.

3.1.19 GetErrorCode Method

GetErrorCode method obtains error code for a message that was queued for sending using
SendAsync method and failed to be sent.

Syntax

[Visual Basic]

Functi on Get Error Code( numvessageNunber As Long) As Long

Example:

numkr r or Code = obj Snt pMai | . Get Err or Code( numvessageNumnber)

[VBScript]

Functi on Get Error Code( numvessageNunber)

Example:

nunEr r or Code = obj Snt pMai | . Get Err or Code( numvessageNunber)

[C#]

int GetErrorCode(int numvessageNumnber);

Example:

i nt nunError Code = obj St pMai | . Get Err or Code( nunVessageNunber) ;

[C++]

HRESULT Get Err or Code( LONG numvessageNunber, LONG' pnunError Code);

Example:

i nt nunError Code = spSnt pMai | - >Get Er r or Code( nunivessageNunber) ;

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

Return value

Returns numeric error code:
0 if message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks
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3.1.20

SendAsync method places a message into a message queue and returns message number which
identifies the message. If the message failed to be sent status of the message becomes
MailStatusFailed and GetErrorCode method can be used to obtain error code.

GetErrorDescription Method

GetErrorDescription method obtains error description for a message that was queued for sending
using SendAsync method and failed to be sent.

Syntax

[Visual Basic]

Function Get ErrorDescri ption(numvessageNunber As Long) As String

Example:

Dim strError As String
strError = obj Snt pMai | . Get Error Descri pti on( nunvessageNunber)

[VBScript]

Function Get ErrorDescri ption(numvessageNunber)

Example:

Dim strError
strError = obj Snt pMai | . Get Error Descri pti on( nunvessageNunber)

[C#]

string GetErrorDescription(int numvessageNunber);

Example:

string strError = obj Smt pMai |l . Get ErrorDescri pti on(nunvessageNunber);

[C++]

HRESULT Get ErrorDescription(LONG numVessageNunber, BSTR* pstrError);

Example:

_bstr_t strError = spSnt pMail ->Get Error Descri pti on( numvessageNunber) ;

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

Return value
Returns extended error information if the message failed to be sent, empty string otherwise.
Remarks

SendAsync method places a message into a message queue and returns message number which
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identifies the message. If message failed to be sent, status of the message becomes
MailStatusFailed and GetErrorDescription method can be used to obtain error description.

3.1.21 Cancel Method

Cancel method cancels sending of a message that was queued for sending using SendAsync method.
Syntax

[Visual Basic]

Sub Cancel (nunivessageNunber As Long)

Example:

obj Smt pMai | . Cancel numMessageNunber

[VBScript]

Sub Cancel (numvessageNunber)

Example:

obj Snt pMai | . Cancel numMVessageNunber

[C#]

voi d Cancel (i nt numVessageNunber);

Example:

obj Smt pMai | . Cancel (numvessageNunber) ;

[C++]

HRESULT Cancel (LONG nuniVessageNunber) ;

Example:

spSnt pMai | - >Cancel ( numvessageNunber) ;

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

Return value
None.
Remarks

SendAsync method places a message into a message queue and returns message number which
identifies the message. Use Cancel method to cancel sending of the message. Only messages that
have status MailStatusQueued or MailStatusSending can be canceled. If the message is currently
transferred and its status is MailStatusSending, Cancel method doesn't cause the transfer to stop
immediately. Message is marked for cancellation and will be canceled some time later. The message
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3.1.22

is actually canceled when its status changes to MailStatusCanceled.

CancelAll Method

CancelAll method cancels sending of all messages that were queued for sending using SendAsync
method.

Syntax

[Visual Basic]

Sub Cancel Al l ()

Example:

obj Smt pMai | . Cancel Al |

[VBScript]

Sub Cancel Al l ()

Example:

obj Snt pMai | . Cancel Al |

[C#]

voi d Cancel ();

Example:

obj St pMai | . Cancel ALl ();

[C++]

HRESULT Cancel Al l ();

Example:

spSnt pMai | - >Cancel Al l ();

Parameters
None.

Return value
None.
Remarks

SendAsync method places a message into a message queue and returns message number which
identifies the message. Use CancelAll method to cancel sending of all messages that were not sent
yet. Only messages that have status MailStatusQueued or MailStatusSending will be canceled. If a
message is currently transferred and its status is MailStatusSending, CancelAll method doesn't
cause the transfer to stop immediately. Message is marked for cancellation and will be canceled some
time later. The message is actually canceled when its status changes to MailStatusCanceled.
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3.1.23 GetLastErrorCode Method

GetLastErrorCode method returns error code of the last synchronous send operation.
Syntax

[Visual Basic]

Function GetlLastErrorCode() As Long

Example:

nunEr r or Code = obj Snt pMai | . Get Last Err or Code

[VBScript]

Functi on Get Last Error Code()

Example:

numkr r or Code = obj Snt pMai | . Get Last Err or Code

[C#]

i nt Get Last Error Code();

Example:

i nt nunmErrorCode = obj Snt pMai | . Get Last Err or Code() ;

[C++]

HRESULT Get Last Error Code( LONG* pnunkEr r or Code) ;

Example:

i nt numkrrorCode = spSnt pMai | - >CGet Last Err or Code() ;

Parameters

None.
Return value

Returns numeric error code:
0 if the last message was sent successfully;
-1 if connection to the server failed or in case of other Winsock errors;
>0 SMTP error code as defined in REC 821 page 34-35.

Remarks
GetLastErrorCode can be used to obtain error code of the last synchronous send operation, i.e. the

error code from the last call of Send, SimpleSend, SimpleSendAttachment, SimpleSendScriptable or
SimpleSendAttachmentScriptable.
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3.1.24 GetLastErrorDescription Method

GetLastErrorDescription method returns error description of the last synchronous send operation.
Syntax

[Visual Basic]

Function GetlLastErrorDescription() As String

Example:

Dim strError As String
strError = obj Snt pMai | . Get Last Error Descri ption

[VBScript]

Function GetlLastErrorDescription()

Example:

Dim strError
strError = obj Snt pMai | . Get Last Error Descri ption

[C#]

string GetlLastErrorDescription();

Example:

string strError = obj Snt pMai | . Get Last Error Descri ption();

[C++]

HRESULT Get Last ErrorDescription(BSTR* pstrError);

Example:

_bstr_t strError = spSntpMil->GetLast ErrorDescription();

Parameters

None.

Return value

Returns extended error information if the last message failed to be sent, empty string otherwise.
Remarks

If programming language you are using does not support out parameters (JavaScript for example),
GetLastErrorDescription can be used to obtain extended error information of the last synchronous

send operation, i.e. the error description from the last call of Send, SimpleSend,
SimpleSendAttachment, SimpleSendScriptable or SimpleSendAttachmentScriptable.
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3.1.25 GetQueueSize Method

GetQueueSize method returns number of e-mail messages queued for sending.
Syntax

[Visual Basic]

Functi on Get QueueSi ze() As Long

Example:

numvessages = obj Snt pMai | . Get QueueSi ze

[VBScript]

Function Get QueueSi ze()

Example:

numvessages = obj Snt pMai | . Get QueueSi ze

[C#]

i nt Get QueueSi ze();

Example:
i nt numvessages = obj Snt pMai | . Get QueueSi ze() ;

[C++]

HRESULT Get QueueSi ze( LONG* pnunkr r or Code) ;

Example:

int numvessages = spSnt pMai | - >Get QueueSi ze();

Parameters

None.

Return value

Returns number of messages in AddEmail queue.

Remarks

SendAsync method places a message into a message queue and exits. Afer that AddEmail starts

sending messages from the queue using background thread(s). Use GetQueueSize method to get the
number of messages queued for sending.

3.1.26 OnStatusChange Event

OnStatusChange event is fired on every status change for the message that was queued for sending
using SendAsync method.
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Syntax

[Visual Basic]

Sub OnSt at usChange( nunmvessageNunber As Long, nunmNewStatus As Long)

[C#]

voi d OnSt at usChange(i nt numvessageNunber, int numNewSt at us);

[C++]

void __ cdecl OnStatusChange(LONG numvessageNunber, LONG nunNewSt at us ) ;

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

numNewSt at us [ i n]
New status of the message, one of the values from the MailStatus enumeration.

Return value

None.

Remarks

SendAsync method places a message into a message queue and returns message number which
identifies the message. OnStatusChange event is used to notify application about changes to the
message status. Initially message status is MailStatusQueued. When AddEmail starts sending the
message its status changes to MailStatusSending. When the message is sent successfully status
changes to MailStatusSent. Status becomes MailStatusFailed if AddEmail was unable to send the

message. If the message was canceled using Cancel or CancelAll method its status becomes
MailStatusCanceled.

3.1.27 OnProgress Event

OnProgress event is fired during message transfer to notify application about sending progress.
Syntax

[Visual Basic]

Sub OnProgress(nunvessageNunber As Long, nunBytesSent As Long, nunBytesTotal As
Long)

[C#]

voi d OnProgress(int numvessageNunber, int nunmBytesSent, int nunBytesTotal);

[C++]

void __cdecl OnProgress(LONG numvessageNunber, LONG nunBytesSent, LONGC
nunmByt esTot al ) ;

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



Reference 68

3.1.28

3.1.29

Parameters

numvessageNunber [in]
Message number returned from the SendAsync method.

numByt esSent [ i n]
Number of bytes transferred already.

numByt esTotal [in]
Total number of bytes in the message.

Return value

None.

Remarks

OnProgress is fired after block of data is transferred. In current version of AddEmail block size is 8

kilobytes. If the total number of bytes in the message is smaller than the block size, OnProgress event
is not fired.

OnStatusChangeHandler Property

OnStatusChangeHandler property specifies a handler for the OnStatusChange event.
Syntax

[JavaScript]

snt pMai | . OnSt at usChangeHandl er = Mai | OnSt at usChange;

function Mail OnSt at usChange( nai | Nunber, st at us)
{

}

Remarks

Use OnStatusChangeHandler property to set a handler for the OnStatusChange event in script
languages such as VBScript or JavaScript.

OnProgressHandler Property

OnProgressHandler property specifies a handler for the OnProgress event.
Syntax

[JavaScript]

snt pMai | . OnProgr essHandl er = Mai | OnProgr ess;

function Mail OnProgress(mail Nunber, bytesSent, bytesTotal)
{
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3.2
3.2.1

Remarks

Use OnProgressHandler property to set a handler for the OnProgress event in script languages such
as VBScript or JavaScript.

MailMessage

Overview

MailMessage object represents e-mail message and contains all message data: sender, recipients,
subject, body, attachments etc.

Syntax:

[Visual Basic]

Di m obj Mai | Message As New AddEnmi | Li b. Mai | Message
obj Mai | Message. MessageSubj ect = "test"

[VBScript]

Di m obj Mai | Message
Set obj Mai | Message = Creat eObj ect (" AddEmai | . Mai | Message")
obj Mai | Message. MessageSubj ect = "test"

[C#]

AddEnai | Li b. Mai | MessageCl ass obj Mai | Message = new AddEnai | Li b. Mai | Messaged ass() ;
obj Mai | Message. MessageSubj ect = "test";

[C++]

AddEnai | Li b: : | Mai | MessagePtr spMai | Message;
spMai | Message. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Message) ) ;
spMai | Message- >Put MessageSubj ect ("test");

Properties:
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Sender

Sender of e-mail message.

ReplyTo

Reply-to address.

MessageSubject

Subject of e-mail message.

MessageBody Body of e-mail message.

MessageBodyFormat Format of the body of e-mail message.
MessageBodyEncoding Encoding of the body of e-mail message.
MessageBodyCharset Character set of the body of e-mail message.
AltMessageBody Alternative text-only body of e-mail message.
AltMessageBodyEncoding Encoding of the alternative body of e-mail message.
AltMessageBodyCharset Character set of the alternative body of e-mail message.
MessagePriority Priority of e-mail message.

Messageld Id of e-mail message.

MessageBodyFile

Filename of the file that contains body of e-mail message.

RequestReadReceipt

Request a read receipt for the message.

Methods:

AddRecipient Adds recipient to the To field of e-mail message.
AddCcRecipient Adds recipient to the Cc field of e-mail message.
AddBccRecipient Adds recipient to the Bcc field of e-mail message.
AddAttachment Adds attachment to e-mail message.

AddHeader Adds header value to e-mail message.

ClearAttachments

Clears list of attachments.

ClearRecipients

Clears list of recipients in the To field of e-mail message.

ClearCcRecipients

Clears list of recipients in the Cc field of e-mail message.

ClearBccRecipients

Clears list of recipients in the Bcc field of e-mail message.

ImportHTML

Imports HTML file with embedded images.

Sender Property

Sender property specifies sender of e-mail message.

Syntax

[Visual Basic]

Di m obj Mai | Address As New AddEmmai | Li b. Mai | Addr ess

obj Mai | Addr ess. Addr ess

obj Mai | Message. Sender

"me@ryi sp. cont'
obj Mai | Addr ess
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[VBScript]

Di m obj Mai | Addr ess

Set obj Mai | Address = Creat eObj ect ("AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Address = "nme@ryi sp. cont

obj Mai | Message. Sender = obj Mai | Addr ess

[C#]

AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnmai | Li b. Mai | Addr essCl ass() ;
obj Mai | Addr ess. Address = "me@yi sp. cont';
obj Mai | Message. Sender = obj Mai | Addr ess;

[C++]

HRESULT get _Sender (| Mai | Address**);
HRESULT put _Sender (| Mai | Addr ess*) ;

AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;

spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Address)) ;
spMai | Addr ess- >Put Addr ess(" ne@ryi sp. coni);

spMai | Message- >Put Sender (spMai | Addr ess) ;

Remarks
Set Sender property to the prepared MailAddress object containing e-mail address and optional name

of the sender of the message. E-mail address and name will appear in the From field of the message.
This property is required and can't be empty.

ReplyTo Property

ReplyTo property specifies e-mail address to reply to.
Syntax

[Visual Basic]

Di m obj Mai | Address As New AddEnmi | Li b. Mai | Addr ess
obj Mai | Addr ess. Address = "nme@yi sp. cont
obj Mai | Message. Repl yTo = obj Mai | Addr ess

[VBScript]

Di m obj Mai | Addr ess

Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Address = "me@yi sp. cont'

obj Mai | Message. Repl yTo = obj Mai | Addr ess

[C#]

AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnai | Li b. Mai | Addr essC ass() ;
obj Mai | Addr ess. Addr ess "me@ryi sp. cont';
obj Mai | Message. Repl yTo obj Mai | Addr ess;

[C++]

HRESULT get _Repl yTo(I| Mai | Address**);
HRESULT put _Repl yTo(I| Mai | Addr ess*);
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AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;

spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Addr ess)) ;

spMai | Addr ess- >Put Addr ess(" ne@ryi sp. coni') ;

spMai | Message- >Put Repl yTo( spMai | Addr ess) ;

Remarks

Set ReplyTo property to the prepared MailAddress object containing e-mail address and optional
name of a person who should receive a reply. E-mail address and name will be used when recipient

replies to the message. This property is optional and can be empty. If ReplyTo is not set e-mail
address and name from the Sender property will be used when replying to the message.

3.2.4 MessageSubject Property

MessageSubject property specifies subject of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessageSubj ect = "test nessage”
[VBScript]

obj Mai | Message. MessageSubj ect = "test nessage"
[C#]

obj Mai | Message. MessageSubj ect = "test nessage”;
[C++]

HRESULT get MessageSubj ect (BSTR*) ;
HRESULT put _MessageSubj ect (BSTR);

spMai | Message- >Put MessageSubj ect ("t est nessage");

Remarks

Default value of MessageSubject property is an empty string. The message will have no subject if
MessageSubject property contains an empty string.

3.2.5 MessageBody Property

MessageBody property specifies main body of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessageBody = "Testing, testing, testing..."

[VBScript]
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obj Mai | Message. MessageBody = "Testing, testing, testing..."

[C#]

obj Mai | Message. MessageBody = "Testing, testing, testing...";

[C++]

HRESULT get MessageBody(BSTR*) ;
HRESULT put _MessageBody(BSTR);

spMai | Message- >Put MessageBody(" Testing, testing, testing...");

Remarks
MessageBody can contain plain text or HTML depending on the value of MessageBodyFormat

property. Default value of MessageBody property is an empty string. The message will have no body if
MessageBody property contains an empty string.

MessageBodyFormat Property

MessageBodyFormat property specifies format of main body of e-mail message.
Syntax

[Visual Basic]

Mai | For mat Text

obj Mai | Message. MessageBodyFor mat

[VBScript]

obj Mai | Message. MessageBodyFormat = 0 ' Mai | For nat Text

[C#]

obj Mai | Message. MessageBodyFor nat = AddEnai | Li b. Mai | For mat . Mai | For mat Text ;

[C++]

HRESULT get _MessageBodyFor mat ( Mai | For mat *) ;
HRESULT put MessageBodyFor mat ( Mai | For mat ) ;

spMai | Message- >Put MessageBodyFor mat ( AddEmai | Li b: : Mai | For mat Text) ;

Remarks

MessageBodyFormat property indicates format of main body of the message. Possible format values
are defined in the MailFormat enumeration. Default value of MessageBodyFormat property is
MailFormatText.
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3.2.7

3.2.8

MessageBodyEncoding Property

MessageBodyEncoding property specifies encoding of main body of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessageBodyEncodi ng = Mai | Encodi ng7Bi t

[VBScript]

obj Mai | Message. MessageBodyEncodi ng = 1 ' Mai | Encodi ng7Bi t

[C#]

obj Mai | Message. MessageBodyEncodi ng = AddEnmi | Li b. Mai | Encodi ng. Mai | Encodi ng7Bi t;

[C++]

HRESULT get _MessageBodyEncodi ng( Mai | Encodi ng*) ;
HRESULT put _MessageBodyEncodi ng( Mai | Encodi ng) ;

spMai | Message- >Put MessageBodyEncodi ng( AddEnmi | Li b: : Mai | Encodi ng7Bit);

Remarks

MessageBodyEncoding property indicates which encoding method should be used for main body of
the message. Possible encoding values are defined in the MailEncoding enumeration. Default value of
MessageBodyEncoding property is MailEncodingDefault, which means that AddEmail will try to
determine best encoding method based on the content of message body. Application can specify
encoding method to save time needed to analyze message body. Use MailEncoding7Bit if message
body contains only English ASCII characters 32-126 and line length does not exceed 76 characters.
Use MailEncoding8Bit if message body contains non-English ASCII characters and line length does
not exceed 76 characters. Use MailEncodingQuotedPrintable if line length exceeds 76 characters
and formatting should be preserved. Use MailEncodingBase64 for Unicode messages or if message
body contains many non-English ASCII characters. For HTML messages MailEncodingBase64 or
MailEncodingQuotedPrintable is recommended.

MessageBodyCharset Property

MessageBodyCharset property specifies character set of main body of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessageBodyChar set = "uni code”

[VBScript]

"uni code"

obj Mai | Message. MessageBodyChar set

[C#]
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obj Mai | Message. MessageBodyChar set = "uni code";

[C++]

HRESULT get MessageBodyChar set (BSTR*) ;
HRESULT put _MessageBodyChar set (BSTR) ;

spMai | Message- >Put MessageBodyChar set (" uni code") ;

Remarks

MessageBodyCharset indicates which character set should be used to display main body of the
message. Default value of MessageBodyCharset property is an empty string. Most common values of
MessageBodyCharset property are:

"us-ascii" - US ASCII

"is0-8859-1" - Western European (1SO)
"windows-1252" - Western European (Windows)
"unicode” - Unicode (internally converted to UTF-8)
"is0-8859-2" - Central European (ISO)
"windows-1250" - Central European (Windows)

For more information please visit Charsets in Microsoft Internet Explorer.

3.2.9 AltMessageBody Property

AltMessageBody property specifies alternative text-only body of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. Al t MessageBody

"Testing, testing, testing..."

[VBScript]

obj Mai | Message. Al t MessageBody = "Testing, testing, testing..."

[C#]

obj Mai | Message. Al t MessageBody = "Testing, testing, testing...";

[C++]

HRESULT get _Al t MessageBody( BSTR*) ;
HRESULT put _Al t MessageBody( BSTR) ;

spMai | Message- >Put Al t MessageBody( " Testing, testing, testing...");

Remarks

AltMessageBody specifies alternative plain-text version of HTML message. AltMessageBody will be
displayed if e-mail client does not support HTML e-mail messages. Default value of AltMessageBody
property is an empty string.

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



Reference 76

3.2.10 AltMessageBodyEncoding Property

AltMessageBodyEncoding property specifies encoding of alternative plain-text body of e-mail
message.

Syntax

[Visual Basic]

obj Mai | Message. Al t MessageBodyEncodi ng = Mai | Encodi ng7Bi t

[VBScript]

obj Mai | Message. Al t MessageBodyEncodi ng 1 ' Mail Encodi ng7Bi t

[C#]

obj Mai | Message. Al t MessageBodyEncodi ng = AddEmai | Li b. Mai | Encodi ng. Mai | Encodi ng7Bi t;

[C++]

HRESULT get _Al t MessageBodyEncodi ng( Mai | Encodi ng*) ;
HRESULT put _Al t MessageBodyEncodi ng( Mai | Encodi ng) ;

spMai | Message- >Put Al t MessageBodyEncodi ng( AddEmai | Li b: : Mai | Encodi ng7Bit);

Remarks

AltMessageBodyEncoding property indicates which encoding method should be used for alternative
plain-text body of the message. Possible encoding values are defined in the MailEncoding
enumeration. Default value of AltMessageBodyEncoding property is MailEncodingDefault, which
means that AddEmail will try to determine best encoding method based on the content of alternative
message body. Application can specify encoding method to save time needed to analyze alternative
message body. Use MailEncoding7Bit if alternative message body contains only English ASCII
characters 32-126 and line length does not exceed 76 characters. Use MailEncoding8Bit if alternative
message body contains non-English ASCII characters and line length does not exceed 76 characters.
Use MailEncodingQuotedPrintable if line length exceeds 76 characters and formatting should be
preserved. Use MailEncodingBase64 for Unicode messages or if alternative message body contains
many non-English ASCII characters.

3.2.11 AltMessageBodyCharset Property

AltMessageBodyCharset property specifies character set of alternative plain-text body of e-mail
message.

Syntax

[Visual Basic]

obj Mai | Message. Al t MessageBodyChar set = "uni code"

[VBScript]

obj Mai | Message. Al t MessageBodyChar set = "uni code"
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[C#]

obj Mai | Message. Al t MessageBodyChar set = "uni code";

[C++]

HRESULT get _Al t MessageBodyChar set (BSTR*) ;
HRESULT put _Al t MessageBodyChar set ( BSTR) ;

spMai | Message- >Put Al t MessageBodyChar set (" uni code") ;

Remarks

AltMessageBodyCharset indicates which character set should be used to display alternative body of
the message. Default value of AltMessageBodyCharset property is an empty string. Most common
values of AltMessageBodyCharset property are:

"us-ascii" - US ASCII

"is0-8859-1" - Western European (1ISO)
"windows-1252" - Western European (Windows)
"unicode"” - Unicode (internally converted to UTF-8)
"is0-8859-2" - Central European (ISO)
"windows-1250" - Central European (Windows)

For more information please visit Charsets in Microsoft Internet Explorer.

MessagePriority Property

MessagePriority property specifies priority of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessagePriority = Mail PriorityHi gh

[VBScript]

obj Mai | Message. MessagePriority = 1 'Mil PriorityHigh

[C#]

obj Mai | Message. MessagePriority = AddEmai |l Lib. Mail Priority. Mail PriorityHi gh;

[C++]

HRESULT get _MessagePriority(MilPriority*);
HRESULT put _MessagePriority(MiilPriority);

spMai | Message- >Put MessagePriority(AddEmail Lib:: MailPriority);

Remarks

MessagePriority property indicates priority of the message. Possible priority values are defined in the
MailPriority enumeration. Default value of MessagePriority property is MailPriorityNormal.
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3.2.13 Messageld Property

Messageld property specifies ID of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. Messagel d "123456abc@ryi sp. cont

[VBScript]

obj Mai | Message. Messagel d = "123456abc@yi sp. cont

[C#]

obj Mai | Message. Messagel d "123456abc@ryi sp. cont';

[C++]

HRESULT get _Messagel d( BSTR*);
HRESULT put _Messagel d( BSTR);

spMai | Message- >Put Messagel d( " 123456abc@ryi sp. cont') ;

Remarks
Messageld is globally unique ID of e-mail message. Default value of Messageld property is empty

string. In most cases application should not specify ID of the message because it will be assigned by
AddEmail or by the outgoing mail server.

3.2.14 MessageBodyFile Property

MessageBodyFile property specifies filename of the file that contains main body of e-mail message.
Syntax

[Visual Basic]

obj Mai | Message. MessageBodyFile = "test. htm"

[VBScript]

obj Mai | Message. MessageBodyFile = "test. htm"

[C#]

obj Mai | Message. MessageBodyFile = "test. htm";

[C++]

HRESULT get _MessageBodyFi |l e( BSTR*);
HRESULT put _MessageBodyFi | e( BSTR) ;

spMai | Message- >Put MessageBodyFil e("test. htm ");
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Remarks
Instead of supplying message body using MessageBody property, application can set
MessageBodyFile property to the filename of the file that contains the body. AddEmail will read

message body from the supplied file. Please note that specified file is not loaded to memory
immediately and must exist until the message is sent.

3.2.15 RequestReadReceipt Property

RequestReadReceipt property specifies whether a read receipt for the message is requested.
Syntax

[Visual Basic]

obj Mai | Message. Request ReadRecei pt = True

[VBScript]

obj Mai | Message. Request ReadRecei pt = True

[C#]

obj Mai | Message. Request ReadRecei pt = true;

[C++]

HRESULT get Request ReadRecei pt ( VARl ANT_BOCL*) ;
HRESULT put _Request ReadRecei pt ( VARl ANT_BOQL) ;

spMai | Message- >Put Request ReadRecei pt ( VARI ANT_TRUE) ;

Remarks

Set RequestReadReceipt to True if you want to request a read receipt for the message. Default value
of RequestReadReceipt property is False.

3.2.16 AddRecipient Method

AddRecipient method adds recipient to the To field of e-mail message.
Syntax

[Visual Basic]

Sub AddReci pi ent (obj Mai | Address As AddEnmmai | Li b. Mai | Addr ess)

Example:
Di m obj Mai | Address As New AddEnmi | Li b. Mai | Addr ess

obj Mai | Addr ess. Address = "soneone@onei sp. cont'
obj Mai | Message. AddReci pi ent obj Mai | Addr ess

[VBScript]
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Sub AddReci pi ent (obj Mai | Addr ess)

Example:

Di m obj Mai | Addr ess

Set obj Mai | Address = Creat eObj ect ("AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Address = "soneone@onei sp. cont'

obj Mai | Message. AddReci pi ent obj Mai | Addr ess

[C#]

voi d AddReci pi ent (AddEnai | Li b. Mai | Addr essCl ass obj Mai | Addr ess) ;

Example:
AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnmai | Li b. Mai | Addr essC ass() ;

obj Mai | Addr ess. Address = "soneone@onesp. cont';
obj Mai | Message. AddReci pi ent (obj Mai | Addr ess) ;

[C++]

HRESULT AddReci pi ent (| Mai | Addr ess* obj Mai | Addr ess) ;

Example:

AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;

spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Address)) ;
spMai | Addr ess- >Put Addr ess( " soneone@onei sp. cont') ;

spMai | Message- >AddReci pi ent (spMai | Addr ess) ;

Parameters

obj Mai | Address [in]
Prepared MailAddress object containing e-mail address and name of the recipient.

Return value

None.

Remarks

Use AddRecipient method to add prepared MailAddress object containing e-mail address and optional
name of the recipient of e-mail message. E-mail address and name will appear in the To field of the

message. Application can call AddRecipient method more than once to have more than one recipient
in the To field.

3.2.17 AddCcRecipient Method

AddCcRecipient method adds recipient to the Cc field of e-mail message.
Syntax

[Visual Basic]

Sub AddCcReci pi ent (obj Mai | Address As AddEnmi | Li b. Mai | Addr ess)

Example:
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Di m obj Mai | Address As New AddEmmai | Li b. Mai | Addr ess
obj Mai | Addr ess. Address = "soneone@onei sp. cont'
obj Mai | Message. AddCcReci pi ent obj Mai | Addr ess
[VBScript]
Sub AddCcReci pi ent (obj Mai | Addr ess)
Example:
Di m obj Mai | Addr ess
Set obj Mai | Address = Creat eObj ect ("AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Address = "soneone@onei sp. cont'
obj Mai | Message. AddCcReci pi ent obj Mai | Addr ess
[C#]
voi d AddCcReci pi ent (AddEmai | Li b. Mai | Addr essC ass obj Mai | Addr ess);
Example:
AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnmai | Li b. Mai | Addr essC ass() ;
obj Mai | Addr ess. Address = "soneone@onesp. cont';
obj Mai | Message. AddCcReci pi ent (obj Mai | Addr ess) ;
[C++]
HRESULT AddCcReci pi ent (I Mai | Addr ess* obj Mai | Addr ess);
Example:
AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;
spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Address)) ;
spMai | Addr ess- >Put Addr ess( " soneone@onei sp. cont') ;
spMai | Message- >AddCcReci pi ent (spMai | Addr ess) ;
Parameters
obj Mai | Address [in]
Prepared MailAddress object containing e-mail address and name of the recipient.
Return value
None.
Remarks
Use AddCcRecipient method to add prepared MailAddress object containing e-mail address and
optional name of the recipient of e-mail message. E-mail address and name will appear in the Cc field
of the message. Application can call AddCcRecipient method more than once to have more than one
recipient in the Cc field.

3.2.18 AddBccRecipient Method

AddBccRecipient method adds Bcc (invisible) recipient to e-mail message.

Syntax
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[Visual Basic]

Sub AddBccReci pi ent (obj Mai | Address As AddEnai | Li b. Mai | Addr ess)

Example:
Di m obj Mai | Address As New AddEnmi | Li b. Mai | Addr ess

obj Mai | Addr ess. Address = "soneone@onei sp. cont'
obj Mai | Message. AddBccReci pi ent obj Mai | Addr ess

[VBScript]

Sub AddBccReci pi ent (obj Mai | Addr ess)

Example:

Di m obj Mai | Addr ess

Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")
obj Mai | Addr ess. Address = "soneone@onei sp. cont'

obj Mai | Message. AddBccReci pi ent obj Mai | Addr ess

[C#]

voi d AddBccReci pi ent (AddEnmi | Li b. Mai | Addr essCl ass obj Mai | Addr ess) ;

Example:
AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnai | Li b. Mai | Addr essC ass() ;

obj Mai | Addr ess. Address = "soneone@onesp. cont';
obj Mai | Message. AddBccReci pi ent (obj Mai | Addr ess) ;

[C++]

HRESULT AddBccReci pi ent (I Mai | Addr ess* obj Mai | Addr ess) ;

Example:
AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;
spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Address));

spMai | Addr ess- >Put Addr ess(" sonmeone@onei sp. cont') ;
spMai | Message- >AddBccReci pi ent (spMai | Addr ess) ;

Parameters

obj Mai | Address [in]
Prepared MailAddress object containing e-mail address and name of the recipient.

Return value

None.

Remarks

Use AddBccRecipient method to add prepared MailAddress object containing e-mail address and
optional name of the recipient of e-mail message. E-mail address and name will not visible, but the

message will be sent to Bcc recipients. Application can call AddBccRecipient method more than once
to specify more than one Bcc recipient.
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3.2.19 AddAttachment Method

AddAttachment method adds attachment to e-mail message.
Syntax

[Visual Basic]

Sub AddAt t achnent (obj Mai | Attachnent As AddEnmmi |l Li b. Mai | Attachnent)

Example:
Di m obj Mai | Attachnment As New AddEnmil Li b. Mai | Attachnent

obj Mai | Attachnent.File = "c:\files\docunment. pdf"
obj Mai | Message. AddAt t achnent obj Mai | Att achnent

[VBScript]

Sub AddAt t achnent (obj Mai | Att achnent)

Example:

Di m obj Mai | Att achment

Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\fil es\docunent. pdf"

obj Mai | Message. AddAt t achnent obj Mai | Att achnent

[C#]

voi d AddAttachnent (AddEnmi | Li b. Mai | Attachnment Cl ass obj Mai | Attachnent);

Example:

AddEnai | Li b. Mai | Attachnent Cl ass obj Mai | Attachnment = new
AddEnai | Li b. Mai | Attachnent d ass();

obj Mai | Attachnent.File = "c:\\fil es\\docunent. pdf";

obj Mai | Message. AddAt t achnent (obj Mai | Attachnent) ;

[C++]

HRESULT AddAttachnent (1 Mail Address* obj Mai | Attachment) ;

Example:
AddEnmai | Li b:: 1 Mai | Attachment Ptr spMai |l Attachment;
spMai | At t achnent . Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Attachment));

spMai | Attachnent->PutFile("c:\\fil es\\docunment. pdf");
spMai | Message- >AddAt t achment (spMai | Att achnent) ;

Parameters

obj Mai | Attachnent [in]
Prepared MailAttachment object containing attachment.

Return value
None.

Remarks
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Use AddAttachment method to add prepared MailAttachment object to the e-mail message.
Application can call AddAttachment method more than once to add more than one attachment to the
message.

3.2.20 AddHeader Method

AddHeader method adds header value to e-mail message.
Syntax

[Visual Basic]

Sub AddHeader (strHeader As String, strValue As String)

Example:

obj Mai | Message. AddHeader "X-Mailer", "My Email Application 1.0"

[VBScript]

Sub AddHeader (strHeader, strVal ue)

Example:

obj Mai | Message. AddHeader "X-Mailer", "My Enail Application 1.0"

[C#]

voi d AddHeader (string strHeader, string strValue);

Example:

obj Mai | Message. AddHeader ( "X-Mailer", "My Email Application 1.0" );

[C++]

HRESULT AddHeader (BSTR strHeader, BSTR strVal ue);

Example:

spMai | Message- >AddHeader (" X-Mailer", "My Email Application 1.0");

Parameters

strHeader [in]
String.

strVal ue [in]
String.

Return value
None.
Remarks

Use AddHeader method to add custom header and its value to the e-mail message. Most common
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header is "X-Mailer", it contains name of an application that sent an e-mail.

3.2.21 ClearAttachments Method

ClearAttachments method clears list of attachments of e-mail message.
Syntax

[Visual Basic]

Sub O ear Attachment s()

Example:

obj Mai | Message. Cl ear Att achnent s

[VBScript]

Sub O earAttachnents()

Example:

obj Mai | Message. C ear Att achnent s

[C#]

void Cl earAttachments();

Example:

obj Mai | Message. Cl ear Att achment s() ;

[C++]

HRESULT Cl ear Attachnents();

Example:

spMai | Message- >C ear Attachnents();

Parameters
None.

Return value
None.
Remarks

Use ClearAttachments method to remove all attachments from e-mail message.
3.2.22 ClearRecipients Method

ClearRecipients method clears list of recipients in To field of e-mail message.
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Syntax

[Visual Basic]

Sub d ear Reci pi ents()

Example:

obj Mai | Message. C ear Reci pi ents

[VBScript]

Sub d ear Reci pi ents()

Example:

obj Mai | Message. Cl ear Reci pi ents

[C#]

voi d C ear Reci pients();

Example:

obj Mai | Message. C ear Reci pi ents();

[C++]

HRESULT C ear Reci pients();

Example:

spMai | Message- >C ear Reci pi ents();

Parameters

None.

Return value

None.

Remarks

Use ClearRecipients method to remove all recipients from To field of e-mail message. Using this

method you can clear list of recipients after sending and reuse prepared MailMessage object to send
the same message to other recipients.

3.2.23 ClearCcRecipients Method

ClearCcRecipients method clears list of recipients in Cc field of e-mail message.
Syntax

[Visual Basic]

Sub d ear CcReci pi ents()
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Example:

obj Mai | Message. Cl ear CcReci pi ents

[VBScript]

Sub d ear CcReci pi ents()

Example:

obj Mai | Message. C ear CcReci pi ents

[C#]

voi d Cl ear CcReci pi ents();

Example:

obj Mai | Message. C ear CcReci pi ents();

[C++]

HRESULT Cl ear CcReci pi ents();

Example:

spMai | Message- >C ear CcReci pi ents();

Parameters

None.

Return value

None.

Remarks

Use ClearCcRecipients method to remove all recipients from Cc field of e-mail message. Using this

method you can clear list of recipients after sending and reuse prepared MailMessage object to send
the same message to other recipients.

3.2.24 ClearBccRecipients Method

ClearBccRecipients method clears list of recipients in Bcc field of e-mail message.
Syntax

[Visual Basic]

Sub d ear BccReci pi ents()

Example:

obj Mai | Message. C ear BccReci pi ents

[VBScript]

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



Reference 88

Sub d ear BccReci pi ents()

Example:

obj Mai | Message. C ear BccReci pi ents

[C#]

voi d C earBccReci pients();

Example:

obj Mai | Message. Cl ear BccReci pi ents();

[C++]

HRESULT Cl ear BccReci pi ents();

Example:

spMai | Message- >C ear BccReci pi ents();

Parameters

None.

Return value

None.

Remarks

Use ClearBccRecipients method to remove all recipients from Bcc field of e-mail message. Using this

method you can clear list of recipients after sending and reuse prepared MailMessage object to send
the same message to other recipients.

3.2.25 ImportHTML Method

ImportHTML method imports HTML file with embedded images.
Syntax

[Visual Basic]

Sub | nport HTML(strFil ename As String)

Example:

obj Mai | Message. | nport HTML "c:\files\emmil.htm"

[VBScript]

Sub | nport HTML(str Fi | enan®e)

Example:
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3.3
3.3.1

obj Mai | Message. | nport HTML "c:\files\email.htm"

[C#]

voi d I mport HTM.(string strFilenane);

Example:

obj Mai | Message. | nport HTML( "c:\\files\\email.htm" );

[C++]

HRESULT | nmport HTML( BSTR st r Fi | enane) ;

Example:

spMai | Message- >l nport HTM_("c: \\files\\emai |l . htm ");

Parameters

strFilename [in]
Filename of the HTML file to be imported.

Return value

None.

Remarks

Use ImportHTML method to create HTML e-mail with embedded images from a file on disk. This
method imports specified HTML file, adds all images referenced in the HTML as inline attachments,
modifies HTML as needed and fills out the MessageBody. Only images located on disk are added as

attachments. Images from the web (http:// or https:// links in HTML) are not attached. Please note that
the current version of AddEmail does not import images specified in CSS using url values.

MailAttachment

Overview

MailAttachment object represents message attachment.
Syntax:

[Visual Basic]

Di m obj Mai | Attachnment As New AddEnmil Li b. Mai | Attachnent
obj Mai | Attachnent.File = "c:\files\docunment. pdf"

[VBScript]

Di m obj Mai | Att achment
Set obj Mai | Attachnent = CreateCbject ("AddEnail . Mail Attachnment")
obj Mai | Attachnent.File = "c:\fil es\docunent. pdf"

[C#]
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AddEnai | Li b. Mai | Attachnent Cl ass obj Mai | Attachnment = new
AddEnai | Li b. Mai | Attachnent d ass();

obj Mai | Attachnent. File

[C++]

"c:\\files\\docunent. pdf";

AddEnmai | Li b:: 1 Mai | Attachment Ptr spMai | Attachment;
spMai | At t achnent . Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Attachment));
spMai | Attachnent->PutFile( "c:\\files\\docurment.pdf" );

Properties:

File Filename of the attachment file.

Name Name of the attachment as it should appear in e-mail message.

Encoding Encoding of the attachment.

ContentType Content type of the attachment.

Charset Character set of the attachment.

Inline Specifies whether the attachment is inline, e.g. embedded in e-malil
message.

Contentld Content Id of the attachment.

Methods:

LoadFromMemory Loads attachment data from memory instead of file.

3.3.2 File Property

File property specifies filename (including path) of the attachment file.

Syntax

[Visual Basic]

obj Mai | Attachnent.File

[VBScript]

"c:\fil es\docunent. pdf"

obj Mai | Attachnent. File

[C#]

"c:\files\docunment. pdf"

obj Mai | Attachnent.File

[C++]

"c:\\files\\docunent. pdf";

HRESULT get Fil e( BSTR*);

HRESULT put _Fil e(BSTR)

spMai | Attachnent->PutFile("c:\\files\\docunment. pdf");
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Remarks
Set File property to the full filename of the attachment. AddEmail will read attachment from the

specified file. Please note that specified file is not loaded to memory immediately and must exist until
the message is sent.

3.3.3 Name Property

Name property specifies name of the attachment as it should appear in the e-mail.
Syntax

[Visual Basic]

obj Mai | Att achnent. Nane = "Report 2004. Pdf"

[VBScript]

obj Mai | Attachnent. Nane = "Report 2004. Pdf"

[C#]

obj Mai | At t achnent . Nane "Report 2004. Pdf *;

[C++]

HRESULT get Name(BSTR*);
HRESULT put _Name(BSTR) ;

spMai | At t achnent - >Put Nane( " Report 2004. Pdf" );

Remarks

Default value of Name property is an empty string. If Name is an empty string, name part of the
filename specified in the File property is used.

3.3.4 Encoding Property

Encoding property specifies encoding of the attachment.
Syntax

[Visual Basic]

Di m attachnent Encodi ng As AddEnmi | Li b. Mai | Encodi ng
obj Mai | At t achnent . Encodi ng = Mai | Encodi ng7Bi t

[VBScript]

Di m attachnent Encodi ng
obj Mai | Att achnent. Encoding = 1 ' Mai | Encodi ng7Bi t

[C#]
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obj Mai | At t achnent . Encodi ng = AddEnmi | Li b. Mai | Encodi ng. Mai | Encodi ng7Bi t ;

[C++]

HRESULT get Encodi ng( Mai | Encodi ng*) ;
HRESULT put _Encodi ng( Mai | Encodi ng) ;

spMai | At t achnent - >Put Encodi ng( AddEnai | Li b: : Mai | Encodi ng7Bi t) ;

Remarks
Encoding property indicates which encoding method should be used for the attachment. Possible
encoding values are defined in the MailEncoding enumeration. Default value of Encoding property is

MailEncodingBase64 and usually doesn't have to be changed. Do not use encoding other than
MailEncodingBase64 for binary files.

3.3.5 ContentType Property

ContentType property specifies content type of the attachment.
Syntax

[Visual Basic]

obj Mai | At t achnent . Cont ent Type "application/ pdf"

[VBScript]

obj Mai | At t achnent . Cont ent Type = "application/ pdf"

[C#]

obj Mai | At t achnent . Cont ent Type = "applicati on/ pdf"

[C++]

HRESULT get _Cont ent Type(BSTR*) ;
HRESULT put _Cont ent Type( BSTR) ;

spMai | At t achnent - >Put Cont ent Type("appl i cation/ pdf");

Remarks

Default value of ContentType property is an empty string. If ContentType is an empty string,
AddEmail tries to read content type from the registry based on file extension of the attachment.

3.3.6 Charset Property

Charset property specifies character set of the attachment.
Syntax

[Visual Basic]

Copyright (c) 2004-2010 Traysoft Inc. All rights reserved.



93 AddEmail 3.0 User Manual

obj Mai | Attachnent. Charset = "i so-8859-1"
[VBScript]

obj Mai | Att achnent . Charset = "i so-8859-1"
[C#]

obj Mai | Attachnent. Charset = "i so-8859-1";
[C++]

HRESULT get _Char set (BSTR*) ;
HRESULT put _Charset (BSTR);

spMai | At t achnent - >Put Char set ("i so-8859-1");

Remarks

Charset indicates which character set should be used to display the attachment. Default value of
Charset property is an empty string. Only text attachments should have Charset property set.

3.3.7 Inline Property

Inline property specifies whether the attachment is inline (embedded in the message).
Syntax

[Visual Basic]

obj Mai | Attachnent.Inline = True

[VBScript]

obj Mai | Attachnent.Inline = True

[C#]

obj Mai | Attachnent.Inline = true;

[C++]

HRESULT get _I nline( VARl ANT_BOOL*);
HRESULT put _I nl i ne( VARl ANT_BOOL) ;

spMai | At t achnent - >Put | nl i ne( VARI ANT_TRUE) ;

Remarks

Default value of Inline property is False. Set Inline property to True for embedded images. Please
refer to the Embeddedimages sample for details.
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3.3.8 Contentld Property

Contentld property specifies ID of the embedded attachment. ID is used to reference attachment in
HTML body of e-mail message.

Syntax

[Visual Basic]

obj Mai | Attachnent. Contentld = "I ngl"
[VBScript]

obj Mai | Attachnent. Contentld = "I ngl"
[C#]

obj Mai | Attachnent. Contentld = "I ngl";

[C++]

HRESULT get _Cont ent | d(BSTR*);
HRESULT put _Cont ent | d(BSTR);

spMai | Att achnent - >Put Content | d(" I ngl");

Remarks
Default value of Contentld property is an empty string. Application should set Contentld of the

embedded attachments to be able to reference them in the HTML body of e-mail message. Please
refer to the Embeddedimages sample for details.

3.3.9 LoadFromMemory Method

LoadFromMemory method loads attachment data from memory instead of file.
Syntax

[C++]

HRESULT LoadFromvenory(BYTE* data, LONG size);

Example:
BYTE dat a[ 100] ;
/1 fill data array

spMai | At t achnent - >LoadFr omvenory(data, 100);
spMai | At t achnent - >Put Nane( " docunent . pdf ") ;

Parameters

data [in]
BYTE array with attachment data.

size [in]
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Size of attachment data.

Return value
None.
Remarks

Use LoadFromMemory method to create in-memory attachment. File property is not used in this
case. Application should set Name property to specify name of the attachment displayed in the e-mail.

3.4 MailAddress

3.4.1 Overview

MailAddress object represents e-mail address.
Syntax:

[Visual Basic]

Di m obj Mai | Address As New AddEnmi | Li b. Mai | Addr ess
obj Mai | Addr ess. Address = "soneone@onei sp. cont'

[VBScript]

Di m obj Mai | Addr ess
Set obj Mai | Address = Creat eObj ect (" AddEmai | . Mai | Addr ess")

obj Mai | Addr ess. Address = "soneone@onei sp. cont'

[C#]

AddEnai | Li b. Mai | Addr essCl ass obj Mai | Address = new AddEnai | Li b. Mai | Addr essC ass() ;
obj Mai | Addr ess. Address = "soneone@onei sp. cont';

[C++]

AddEnai | Li b: : | Mai | AddressPtr spMai | Addr ess;
spMai | Addr ess. Creat el nst ance(__uui dof (AddEmai | Li b: : Mai | Address));
spMai | Addr ess- >Put Addr ess(" sonmeone@onei sp. cont') ;

Properties:
Address E-mail address.
Name Name as it should appear in e-mail message.

3.4.2 Address Property

Address property specifies e-mail address of recipient or sender.

Syntax
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[Visual Basic]

obj Mai | Addr ess. Addr ess "sm thj @onei sp. cont’

[VBScript]

obj Mai | Addr ess. Addr ess

"sm thj @onei sp. cont’

[C#]

obj Mai | Addr ess. Addr ess

"sm thj @onei sp. cont';

[C++]

HRESULT get _Addr ess(BSTR*);
HRESULT put _Addr ess(BSTR);

spMai | Addr ess- >Put Addr ess("smi t hj @onei sp. cont') ;

Remarks

3.4.3 Name Property

Name property specifies name of recipient or sender as it should appear in the e-mail.
Syntax

[Visual Basic]

obj Mai | Addr ess. Nane = "John Smith"

[VBScript]

obj Mai | Addr ess. Nane = "John Smith"

[C#]

obj Mai | Addr ess. Nane = "John Smith";

[C++]

HRESULT get Name(BSTR*);
HRESULT put _Name(BSTR) ;

spMai | Addr ess- >Put Name("John Snith");

Remarks

If Name property is an empty string, only e-mail address will be displayed in the e-mail message.
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3.5

3.6

3.7

3.8

MailFormat

The following table describes possible values of MailFormat enumeration.

Value Numeric value Description
MailFormatText 0 Specifies text format.
MailFormatHtml 1 Specifies HTML format.
MailEncoding

The following table describes possible values of MailEncoding enumeration.

Value Numeric value Description

MailEncodingDefault 0 AddEmail will select suitable encoding based
on the content.

MailEncoding7Bit 1 7-bit encoding suitable for English ASCII text
with line length 76 characters or less.

MailEncoding8Bit 2 8-bit encoding suitable for mostly English
ASCII text with some non-English characters
with line length 76 characters or less.

MailEncodingQuotedPrintable |3 Quoted-printable encoding suitable for English
or non-English ASCII text with any line length.
Preserves line formatting.

MailEncodingBase64 4 Base64 encoding suitable for binary files,
Unicode text or non-English text.

MailPriority

The following table describes possible values of MailPriority enumeration.

Value

Numeric value

Description

MailPriorityHigh

1

Specifies higher priority (urgent) message.

MailPriorityNormal

3

Specifies normal priority message.

MailPriorityLow

5

Specifies lower priority message.

MailStatus

The following table describes possible values of MailStatus enumeration.
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Value

Numeric value

Description

MailStatusQueued

0

Message was added to the queue but
AddEmail didn't start sending it yet.

MailStatusSending

AddEmail is currently sending this message.

MailStatusSent

Message was sent successfully.

MailStatusFailed

AddEmail was unable to send this message.

MailStatusCanceled

1
2
3
4

Message was canceled using Cancel or
CancelAll method.
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